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Welcome! 

 

Thank you for choosing Gradience™ Attendance 2008 for tracking employee absences and time 
off. Our software application includes many features based on the suggestions of our customers, 
and we certainly welcome any further comments or suggestions you may have for improvements.  
  
When combined with other Gradience software such as Gradience™ Records 2008 and 
Gradience™ TimeClock 2008, this powerful tool helps you keep critical employee information 
without entering data twice.  
  
Gradience Attendance makes it easy to record employee absences for employees quickly, lets 
you see time off at a glance and run detailed reports. In addition, the program figures Time-Off 
balances with credits and debits just like a checkbook. Gradience Attendance also helps reveal 
excessive employee absences, which can provide solid evidence for employee discipline or 
termination. The following features in Gradience Attendance will make your job easier and keep 
you organized:  
  
Software Features:  

• Open-ended licensing – Unlike many human resource software applications designed for 
large companies, Gradience Attendance does not require annual licensing. However, we 
do encourage you to purchase upgrades so that you have the latest enhancements and 
newest features to make your job easier.  

• Easy, standalone PC installation – We designed Gradience to be simple to install and get 
running, even for a large client-server system.  

• Password security – Anyone who uses the program must have a login ID and password, 
and you can set different access levels for each user. Additionally, users can encrypt 
sensitive database data such as Social Security numbers. This feature provides peace of 
mind in the event a database or server hard drive containing employee information is lost 
or stolen.  

• Data import – If you already have information from a spreadsheet or other program, you 
can save time setting up Gradience Attendance by importing it.  

• Calendar – Entering absences is easy! Just two clicks and you’re done. You can also enter 
unlimited notes and even paste files.  

• Reminders – Set pop-up reminders for important dates, such as employee anniversaries, 
birthdays and reviews.  

• Time-Off Plans – Once you have set up your Time-Off Plans, Gradience Attendance will 
automatically compute your employees’ benefit credits, debits, carryovers and balances.  

• Reports – You can choose from 18 standard reports and change options to get the 
information you need. Export information to other file formats such as Excel or text, too, as 
well as build your own reports with the powerful Custom Reports module included.  

• Automatic backup – Gradience Attendance can make sure you have a backup of your 
important employee information each time you close the program. With the included DB 
Monitor and DB Maintenance utilities, you can also schedule server backups and perform 
routine database maintenance.  

• Unlimited employees – This application lets you manage attendance records and time-off 
for unlimited employees.  

• Automatic Updates – Automatic Updates help you keep your applications current via the 
Internet. This setting can be manually turned on or off in case automatic updates are not 
desired. 



Gradience Attendance — New Features 

A large number of improvements have been added to Gradience Attendance. The list of changes 
include:  

• Accrual System – Accruals are processed faster than ever before.  
• AutoUpdate** – With the AutoUpdate feature you can set the application for automatic 

updates or manually check for updates at any time.  
• Easier to Upgrade – Upgrading is handled by the Gradience product key entry system. 

You can upgrade Gradience with a new key from inside the program.  
• Encryption Added – Encryption of confidential employee information is now possible in 

Gradience 2008 in the Global Preferences > Global Settings > General Settings tab.  
• Same Familiar Design – Gradience has the same, familiar look and feel you've come to 

know, but now when using Gradience Attendance along with Gradience Records, 
TimeClock and COBRA, a single login/password grants you access to all four programs. 

**Note: Updates versus Upgrades — Updates (also called minor updates) are new releases 
where the first version number has not changed. For example, if you purchase a Gradience 
product with version 10.x.x., you can update to any other version 10.x.x free of charge. Upgrades 
(also called major upgrades) are indicated by a change in the first version number. For example, 
when Gradience improves to the next higher first version number (from 10.x.x to 11.x.x), this is 
called a major upgrade. Major upgrades usually have a significant amount of new features and 
software improvements which warrant an additional charge. Upgrades require an upgrade fee. 
When Gradience performs an AutoUpdate, the fixes applied are minor updates, and are available 
free of charge. Contact Gradience sales for more information on how to purchase major 
upgrades.  



Unlocking the Demo       

You can unlock your demo copy after a new installation, or after you already have installed the 
program.   
  

New Installation 
  

You can unlock your installation immediately, or run any Gradience application in Demo mode. 
Here’s how: 

• During the installation of any Gradience application, you will be prompted to enter your 
license key in the Product Key window. 

• Enter the key in the Key field, or click Next to continue installing the application to run 
Gradience in Demo mode. 

• After running the applications in Demo mode, you will be reminded periodically of the 
Demo trial period remaining and have the option to purchase Gradience Attendance, 
Records or TimeClock. 

Previous Installation   

If you already have installed the demo of Attendance, you can unlock it in one of two ways: 

1. Open Gradience Attendance and click Enter Product Code to enter the product key. 
2. When the Enter Product Key window opens, enter your product key. It is not case-

sensitive. 
3. Click OK. A pop-up will indicate whether the key is valid or not. 

or 

1. Open Gradience Attendance and click Continue in Demo Mode, enter the login and 
password. 

2. From within the program, click Help. On the drop-down menu, click Alter Current Product 
License. 

3. When the pop-up window opens, click on Edit Key. 
4. When the Enter Product Key window opens, enter your product key. It is not case-

sensitive. 
5. Click OK. A pop-up will indicate whether the key is valid or not. 

Note: There is a different product key for each Gradience product. 
  



System Requirements  

 

• Windows XP Professional (SP2), Windows 2000 Professional, Windows 2003 Server or 
Windows Vista 

• Pentium IV or Higher Processor 

• 512 MB available RAM (Random Access Memory) 

• 60 MB available hard disk space CD-ROM drive 

• SVGA monitor with 1024 x 768, High Color or higher 

•  Windows-compatible, graphics-quality printer 



Network Requirements       

• Windows-based Server or PC –  The included database is not compatible with a non-
Windows-based operating system, such as Novell. However, you may run the database on 
a Windows-based server or PC connected to a non-Windows based network.  

• A static (persistent) IP address so the database will always be connected to the client 
application. 

• Proper user license – The database will only allow the purchased number of users to be 
connected at any one time to the database. Wide-Area Networks (WAN) require an 
Enterprise license. The Product Key is affixed to the inside cover of the QuickStart Guide. 

• CD-ROM drive or access to our software download area on www.gradiencesupport.com.  

Citrix and Terminal Services: 
 

   

Although some of our customers have reported running the Gradience with Citrix we have not 
tested our software in such an environment. Also, the Gradience technical assistance is only for 
the applications themselves and not for troubleshooting network issues. We therefore cannot 
offer help with installation on your Citrix network. We also cannot guarantee that standard 
approaches to issue resolution offered by our Technical Support team will work in this 
environment.  
  

You may use the link below to access a PDF that may help.  
  

Citrix support 
  

Below is the only information that we can offer regarding Terminal Services.  
  

Standard Client/Server install on a Terminal Server  
Install the gradience product on the Terminal Services Server using the Add/Remove programs in 
the Control Panel.  
  
 On the Server where gradience is installed, go to Start, Run and enter: hrware.ini. This will 
bring up Notepad with the following info:  
[HRWARE]  

Server=Localhost  

Path=C:\Program Files\GNeil Software\Data\HRWare.gdb  

  

Change the Server information from:  
SERVER=LOCALHOST to SERVER=127.0.0.1. 

Even though Localhost is the same as the IP Address of 127.0.0.1, we have found that in many 
cases you will need to enter the IP Address instead of the name.  
  

We also found that the User would need to be logged on to the Terminal Service with 
Administrative rights. Without administrative rights, our database engine (Firebird 1.5) will not 
function, and the user will not be able to access the database file.  
  
This suggests that an Admin user has privileges to system files/DLL’s that a standard user would 
not. 
  

We welcome your sharing with us any insights that you gain from deploying our software on Citrix  



License Options        

Gradience products have similar licensing schemes. The options currently available are:  

• Professional  – Up to five users can run the program at the same time when connected to 
a single, common database. 

• Enterprise – Site License – Any number of users can run the program at the same time 
when connected to a single, common database from a single site (location).  

• Wide-Area Network (WAN) – licenses for multiple locations are also available. Please call 
for more information. 

   



Installing from the CD Menu        

To begin installing Gradience, follow these steps: 
1. Close ALL running programs.  
2. Insert the Gradience CD-ROM into the appropriate drive of your computer.  
3. The menu will appear. Select which product you want to install. (If the installation menu 

does not appear, click Start, Run. The Run dialog will appear. In the dialog box, type 
D:\setup.exe where D: is the letter of your CD-ROM drive. Click OK or press Enter. ) 

4. Once the installation procedure begins, follow the on-screen instructions to install the 
software. See Setup Types below for more information. It is recommended that you 
accept the default setting for each step of the install process. If you are installing the 
software in a network environment (Client-Server Installation), you should consult your 
network administrator before installation. You must have proper network rights in Windows 
2000 and XP to install Gradience software. 

5. When installation is complete, the Gradience program group will be added to your Start 
menu, and a Gradience TimeClock icon will be on your desktop. 

   



Setup Types       

• STANDALONE: Use this option if you are installing to a standalone computer. This will 
install the application files and database files to your local drive.  

• SERVER: This is the first of two steps in the Client-Server Installation, either for true client-
server configurations or a peer-to-peer network that may be using a workstation PC for the 
database. Choose this option to install the database and application files on the Server 
and before installing the Client application to PC workstations. 

• CLIENT: This is the second step in the Client-Server installation. This will install the 
application files and ask for the Server Name and Database Path. 

   

After clicking on a Setup Type, you will have the following options: 

• EXPRESS: We recommended that you select this option if you are installing or upgrading 
Gradience for the first time. This will take you through the installation process with 
minimum user intervention.  

• CUSTOM: This option is for Advanced Users who have specific installation needs, such as 
installing just the Time Station program on a client.  



Installing Gradience Attendance 

This section explains how to install Gradience Attendance to a Network or Standalone computer, 
and answers frequently asked questions about installing.  
   

Gradience Attendance can be installed on a single standalone workstation or a network for 
database sharing among several users, depending on your needs.  
   

Regardless of which license you purchased, you may install the database to a network folder for 
the purpose of backup. Please consult your network administrator before installing to a network 
folder.  
   



Network Installation – (Client-Server)       

Installing a Client-Server setup is a two-step process. You will need to install to the Server first 
and then to the Workstation(s).  
   

To install to a network requires these items: 

• Windows-Based Server PC – The included database is not compatible with a non-
Windows-based operating system, such as Novell. However, you may run the database on 
a Windows-based server or PC connected to a non-Windows-based network.  

• A static (persistent) IP address so the database will always be connected to the client 
application. 

• Proper user license – The database will allow only the purchased number of users to be 
connected at any one time to the database. Wide-Area Networks (WAN) require an 
Enterprise license. The Product Key is affixed to the inside cover of the CD sleeve. 

• CD-ROM drive or access to our software product download area on 
www.gradiencesupport.com. 

   
NOTE: Gradience cannot provide technical assistance with setting up or maintaining your 
computer network. Please consult your computer manufacturer or network administrator before 
contacting Gradience Tech Support. 
   



Installing Gradience 

1. You may install from a CD or from a download. 

• From a CD:  
Insert the gradience CD, select Install gradience software and double-click on the program 
to be installed.  

• From a Download: 
After following the instructions on downloading Gradience to your desktop, double-click on 
the file to install.  
 
Note: To download, go to www.gradiencesupport.com, click on Download latest 
versions. Select the program that you need, click Download and then click Save. When 
the Save as window opens, put Desktop in the Save in field and then, click Save. 

2. You may install as a Server, a Client or a Stand Alone. 

• Server Installation: 
If installing several gradience programs on your network, only one program needs to be 
installed at the server.  
 
When prompted for the type of installation select Sever. When prompted for Custom or 
Express we recommend Express. If you select Custom you will be given the chance to 
“deselect” certain components. We recommend that you leave all components checked. 
The next prompt will allow you indicate where you want the database to reside. Please 
indicate a folder on physical drive rather than on the drive directly. An example of a custom 
path would be… 
 
j:\gradience\hrware.gdb  
 
Continue to follow the prompts. You will see a screen that shows where the database is 
located. Jot this location down or print this screen as prompted. You will use it at the client 
to verify that it is “pointed” properly to the database.  

• Client Installation: 
DO NOT map a drive from the client to the server. Our software uses TCP/IP to connect to 
the database via port 3050. Also DO NOT use UNC (\\) in either the name of the server or 
the path to the database.  
 
When prompted for the type of installation select Client. When prompted for Custom or 
Express we recommend Express. This workstation will look across the network and “self-
point” to the data up on the server. A prompt will indicate where this client is “pointed”. 
The client MUST be pointed to the exact drive letter on the server where the database is 
located, not a mapped drive. Be sure that the path to the database does NOT have double 
back-slashes (UNC) in the path.  

• Stand Alone Installation: 
When prompted for the type of installation select Stand Alone. When prompted for 
Custom or Express we recommend Express. If you select Custom you will be given the 
chance to “deselect” certain components. We recommend that you leave all components 
checked. The next prompt will allow you indicate where you want the database to reside. 
The database must reside on a physical drive and in a folder on that drive rather than on 
the drive directly. An example of a custom path would be…  
 
j:\gradience\hrware.gdb  



Possible Launch Error:  
 If after installation, you attempt to open gradience software from a remote location you may 
encounter an error message. Some remote-access software cannot resolve Localhost or the 
“name” of the server that can be found in the hrware.ini file of the server, client or stand alone 
workstation respectively. 

Resolution: 

1. 1. Remote to the desktop of the PC where you are attempting to open the program. 
(Server, Client or Stand Alone PC)  

2. 2. Click on Start > Run and enter hrware.ini into the field and click OK.  
3. 3. Second line from the top, change the “Server Name” or “Localhost” to the IP Address of 

the computer where the database is located.  
4. 4. Save and close the NotePad. Re-launch the program. If this fails, “physically” go to that 

computer to launch it.  
 
 

  IMPORTANT NOTE FOR VERSION 6 AND EARLIER USERS 

Gradience does not share the same database with Version 6 or earlier. You will need the 
Gradience Version of each program to share the database among the three separate programs. 
For this reason, you also should upgrade each program to the Gradience Version at the same 
time as Attendance; otherwise, you may create multiple non-synchronized databases. 



Quick Note About Peer-to-Peer Installations       

A peer-to-peer connection allows you to share information between two computers without the 
need of a formal client-server connection. The peer-to-peer connection must be in place 
before following these instructions. See your Network Administrator for more details on setting 
up such a connection.  
   

On the host computer (the one on which you wish the database to reside), follow the instructions 
for a Server installation. Write down the Server Name and Database Path when prompted.   

Note: The Server installation will install both the software application and database files to the 
host computer. Then install the application as a Client on the other computer that will be sharing 
the information, entering the Server Name and Database Path when prompted. 

   



Upgrading from Optima or MyBiz to Gradience 

Version 7 and early editions of Version 8 utilized InterBase 6 open edition as a database engine. 
Nearly all PCs now come with hyper threading as a standard feature. Because of this, we no 
longer employ InterBase 6 because it doesn't work well in a multi-processor or a hyper-threaded 
environment. 
  

We now use Firebird 1.5 as our database engine. It works with multi-processor environments and 
we know of no issues with any brand of hyper threading available. When upgrading to Gradience, 
Firebird will NOT automatically replace InterBase. You will have to uninstall InterBase first as well 
as deleting the gds32.dll file. Then, install Gradience so that Firebird will install as your database 
engine. 
  

If you're upgrading from Optima or MyBiz to Gradience follow these steps: 
1. Back up your current data first. 
2. From your Control Panel click Add/Remove Programs. Look for InterBase 6 and uninstall 

it if you are not using it for another application. If you do not have InterBase 6, you may 
already have Firebird. If so, disregard Steps 3 and 4 below. 

3. After uninstalling InterBase 6 close out of Add/Remove Programs and return to the 
desktop. 

4. Do a search of your C: drive for gds32.dll. If you have this file, delete it. 
5. Now install Gradience. No data needs to be imported. Gradience will read the database 

you already have and upgrade it to a Gradience database. 
  
Note: DO NOT continue to use Optima or MyBiz. These programs will still be able to access the 
data. Using the older version to access the Gradience database may result in a loss of data. 
   

Updating from versions older than Version 6 

  
IMPORTANT! If you have been using Version 6 or below of Attendance Controller first make sure 
that your Benefit Labels are as follows: 
Vacation 

Sick 

Personal 

  

If your Benefit Labels are different, the database will not convert properly for Gradience to read it. 
  

The database in Version 6 and below is dramatically different from what has been used since 
Version 7. If you're upgrading from a version below 6, you will need to upgrade to Version 6 first 
and then to Gradience 2007 (Version 9). Version 6 is on the Gradience CD under the 
BIN/Legacy folder. For assistance, please contact Tech Support at 888-925-7740 or go to 
www.gradiencesupport.com and click on Ask a Question. 
  

Updating from Version 6 

  
IMPORTANT! If you have been using Version 6 or below of Attendance Controller first make sure 
that your Benefit Labels are as follows: 
Vacation 

Sick 

Personal 

  

If your Benefit Labels are different, that database will not convert properly for Gradience to read it. 



  

To upgrade from Version 6, follow these steps: 
1. Install Gradience 2007 (Version 9). For assistance, call Tech Support at 888-925-7740 or 

go to www.gradiencesupport.com and click Ask a Question. 
2. From the desktop click on Programs (or All Programs) > Gradience > Maintenance 

> DB Monitor. 
3. Login with ADMIN, ADMIN 
4. After the DB Monitor opens, click File and Exit and then, click Yes to shut it down. 
5. Now, install Gradience 2008 (Version 10). 



Auto Update Notification for Gradience Attendance 
(Pro/Enterprise) 

Periodically, FREE updates may become available for this version of Gradience Attendance.  
 

 

 When opening the program; if an update is available, the pop-up shown above will appear.  

Accepting the update: 

1. Click See what’s new to be directed to the Web page that contains the download link for 
the program that you need to update.  

2. When the pop up window opens; click Save. If you click Run the software will not install.  
3. A Save as window will open. In the Save in field enter Desktop and click Save to 

download the update.  
 

 



 
 

4. Once the download is complete; an installation icon like the one shown here will appear on 
your desktop.  

 
attendance.exe  

Installing the update:  

1. Double click the installation icon to begin installing the update. You may also refer to the 
section on installation in the Help file within your program for more details.  
 
• Server Installation: 
Install the update on the server or on a workstation that is “behaving” as a server for our 
program first before installing the update on individual “client” workstations. Ensure that 
your current version is not open. Double-click on the downloaded installation icon. When a 
prompt gives a choice between Server, Client and Standalone, select Server. When a 
prompt gives a choice between Custom and Express, select Express. This is true even is 
you had done a Custom installation originally. This is because you already have an 
established ini file [hrware.ini] that will properly direct the program to the data.  
 
• Client Installation: 
Now move the installation icon to the desktop of a client. When a prompt gives a choice 
between Server, Client and Standalone, select Client. When a prompt gives a choice 
between Custom and Express, select Express. Repeat at any additional client 
workstations running this software.  
 
• Stand Alone Installation: 
If you only have the program on one computer and the data is also on that same computer, 
double-click on the downloaded installation icon. When a prompt gives a choice between 
Server, Client and Standalone, select Standalone. When a prompt gives a choice 
between Custom and Express, select Express.  
 

2. When the installation is complete, click the original program icon to open the program.  
3. From within the program, click Help > About to view the updated, multi digit version 

number.  
4. Make a record of this full, multi digit version number. When contacting Tech Support, 

indicate this number.  

Choosing not to update at this time:  

1. Click Remind me later.  

Note: At any time while using the software, you may click on Help at the top. From the drop-down 
menu click Check for Updates. If one is available you will see the pop-up shown here.  
 



 
 

 If no update is available, the pop-up shown below will appear.  
 

 



Auto Update 

Single PC without IT support  

•••• PC needs Internet and FTP access 

•••• User must have PC and Network Administration privileges to complete these tasks. 

Turn on Auto-Update (Client PC)  

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings – Select “Enable Auto 

Update”  
3. From Help Menu – Select “Check for Updates”  

Multiple PCs without IT support  

• User must have PC and Network Administration privileges to complete these tasks.  

Option A 

1. Follow the same steps as used for a single PC environment. 

Option B 

• Gradience Version 10.0.712.13 or higher  
• One of the PCs must have Internet and FTP access  
• Must set up Network Shared Folder for GNSiteMirror application to write to it and for 

other PCs to read from it. The GNSiteMirror application replicates the FTP Update site to a 
local PC or Server.  

 Install GNSiteMirror application   

• See below. 

PC with IT support  

• An IT Administrator must perform these tasks 

Option A   

1. Follow the same steps as used for a single PC environment. 

Option B 

• Gradience Version 10.0.712.13 or higher  
• One of the PCs must have Internet and FTP access  
• Must set up Network Shared Folder for GNSiteMirror application to write to it and for 

other PCs to read from it. The GNSiteMirror application replicates the FTP Update site to a 
local PC or Server.  

Install GNSiteMirror application  



• See below. 

Turn on Auto-Update (Client PC)   

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings “Enable Auto Update”  
3. From Help Menu – Select “Check for Updates”  

Turn Off Auto-Update (Client PC)  

1. From within any Gradience application  
2. Go To Settings > Global Preferences > General Settings – Deselect “Enable Auto 

Update”  
3. Use the management tool of your preference to perform the software installation.  

GNSiteMirror Installation: 

1. Installing the gnsitemirror.msi download application 
- Installing from Gradience CD:  
Navigate to the Gradience CD > BIN > Gradience > Site Mirror folder and double click on the 
Gradience Site Mirror.msi file.  
- If you don’t have a Gradience CD, you can download the file from our Website at: 
http://downloads.gneiltechsupport.com/downloads/Gradience Site Mirror.msi  
After downloading, double-click on the file to start the installation process.  

2. Point the gnsitemirror application to a shared folder 

a. Start the gnsitemirror application. You can find the shortcut at Start > Programs > 
Gradience > Gradience Site Mirror. This will place an icon in the System Tray (near the 
clock in the bottom right).  

b. Right-click on Gradience Site Mirror select Settings.  
c. In the Select Download Folder box, enter the shared path down to the folder where you 

want the clients to pull the updates from. The path will be created if it doesn’t already exist. 
This folder will need to be shared so others can map to it.  

d. Select the options:  
Days between updates (minimum of 7 days) – this is how often this computer will check 
for updates from the FTP site.  
Update Time (computer must be turned on to check updates) – this is when you want this 
computer to check for updates.  
Start Gradience Site Mirror each time Windows starts – (Recommended) – allows the 
program to start automatically each time the computer is restarted.  

e. Click OK.  
f. Right-click on the icon in the System Tray and select Update Now. This will download any 

available updates for the current version.  

3. Set the Auto Update Settings for each Client Computer 

a. From each client computer, open the Gradience program.  
b. Go to Settings > Global Preferences > General Settings Tab and enable the option for 

Automatic Updates. Close out of the Global Preferences.  
c. Go to Help > Auto Updater Settings and set the path to the shared folder.  



Checklist for Setting Up 

Gradience Attendance first needs to collect some information in order to correctly track your 
employee absences. To get started, please follow the checklist below:  

• Change Administrator Password 
• Set Up Locations and Departments 
• Set Up Global Preferences 
• General Codes 
• Enter Employee Data 
• Add additional users  



Getting Started 

   

After installation, open the program. For first time users, enter the program using Login: Admin 
and Password: Admin.  
   
We highly recommend changing the default password by going to Settings > User Security. If 
needed, set up access for others that will need to continue setting up the program. If you need to 
give access to specific locations and departments, or individual employees, set these up first and 
then come back to User Security and complete your desired security access settings. 
  

Before we move on, though, let's discuss how Gradience products function. 
  

Navigating Gradience:   
In general, Gradience software products work like most Windows programs.  However, there are 
some differences in behavior you should note which will make working with Gradience much 
easier. 
  

Saving Records 
Some programs save information immediately after entering the information in the data field. 
Gradience, however, saves data when you click the Save button on the main button bar. This 
feature allows you the chance to edit your information and make changes without committing 
those changes immediately to the database. 
  

Buttons Behave Like Tabs 
Some windows, such as the one shown below, contain buttons designed to summon additional 
data entry areas.  In these cases, the buttons act like popular "tab controls" used in a variety of 
Windows applications.  You may think of the buttons as the label part of a tab, since clicking them 
has the same effect (namely, activating the data entry area associated with that button). 
  

 
  

About Closing Panes with the X (Close) Button 
In Gradience, it is possible to have many different types of data entry windows open at the same 
time in the right hand side "pane" of the application (see graphic below).  Consequently, this 
means those panes are still open (and available for data entry) until you specifically close them 
using either the Close icon or the X button in the color bar to the right.  In the graphic, the red 
arrow points to the X (Close) button which you can use to close a window in the right pane. 
 Remember, windows which you previously opened will appear beneath the current window in 
this pane until you explicitly close them! 
  



 
  

Minimizing and Maximizing Panes 
In addition to being closed, panes can also be minimized and maximized.  In the first of two 
following graphics, notice the ( - )Minus button next to Employee Select in the left pane, just to the 
right of the red arrow.  When clicked, this button will minimize the left pane allowing the right 
Calendar pane to expand into the extra space (see second graphic below, and notice the 
Calendar area enclosed by a red box has become larger).  This feature is handy when you are 
working with limited viewing space as might occur on a small or older monitor. 
  
Both panes maximized  
  

 
  



Left pane minimized  
 

 
  

Good Luck! 
If you have questions about any issues navigating Gradience, please contact Technical Support 
via email or phone.  



Changing the Admin Password       

Option One: Setup rights from scratch.  

Option Two: Duplicate the rights of another user.  

  

See Note at the bottom of these instructions.  
  

Option One: Setup rights from scratch. 
1. From any screen, click Settings > User Security.  
2. Click the New and enter new log-in and Full Name.  
3. Enter new Password and enter password again in the Verify Password field.  

 
Feature Access- By default, the Detail button (not Employee Detail) will be depressed. A 
feature list associated with the Detail button will appear at the lower right,  

1. Click on each item in the Access Rights column one at a time. When you do, the item will 
highlight and a down arrow will appear. Click on the down arrow and a drop-down menu 
will appear.  

2. Click on the selection that provides the appropriate level of access. Repeat this for each 
item on the list of features. You will have an additional button on your screen for each 
Gradience program installed:  

•••• Gradience Attendance  

•••• Gradience Records  

•••• Gradience TimeClock  

•••• Gradience COBRA  
Click each of these buttons respectively and repeat steps 1, 2 & 3 directly above. This will inform 
the database as to the level of access this person will have for each program loaded. Do this only 
once.  
  
Now click the Location/Department button and ensure that the appropriate Locations and 
Departments are checked. If you wish to have access to selected features for all locations and 
departments, you will need to check them all.  
  

Option Two: Duplicate the rights of another user.  
1. Click Settings > User Security and highlight the user who’s rights are to be duplicated. 

To have your “new” administrative password “automatically” have the same, full rights as 
the default administrator login; highlight ADMIN on the list on the left. See first “Note” at 
the bottom of these instructions.  

2. Click the double-green checkmarks (Save as) button at the top. A pop-up window will 
open.  

3. Enter the new login, enter the name of the new user, enter the new password and enter 
the password again.  

4. Click Save.  
  

Notes:  
1. To deactivate ADMIN, Click on ADMIN on the list on the left and then, under Is User 

Active, click No.  
2. To “nearly” duplicate another user’s rights, follow the steps in Option Two but before 

saving, “change” the access rights to those features that need to be restricted or 
enhanced. Then, click Save.  

   
   



Creating Locations and Departments       

Locations and Departments are required and must be assigned to each of your Employees (See 
Adding New Employees to assign Location/Department to employees). 
   
Note: When setting up Locations and Departments for the first time, a Location must be set up 
first, and then you may assign a Department to that Location.   



Setting up Locations and Departments 

Setting up Locations and Departments is a critical task and must be performed before you can proceed with 

other data entry steps. During the process, you will create Locations first, and then Departments afterward. 

Departments then can be assigned to Locations. Follow these steps: 

1. Click on Settings > Locations/Departments.  
2. With Locations already selected, click New, enter the name of the new location and click 

Save. All of the departments that have been created thus far will be made available to the 
new location. Simply check those departments that are appropriate to the new location and 
leave unchecked any departments that do not apply to the new location.  

3. To create a new department, click Departments and then click New.  
4. Enter the name of the new department and click Save. It will be available to all locations. 

Assign as needed by checking the new department for each location for which it is valid. 
Leave it unchecked for those locations for which it is not valid.  
 
Note: After creating new Locations or Departments, you need to refresh the Employee 
Detain screen for them to be available. To do so, look to the upper right. Just under the 
Gradience logo click the black X in the white box.  

NOTE: As you add more locations and departments, you will see that each location has ALL of 
the departments you have created. However, only those departments you assign to a location will 
show up when assigning them on other screens. You may not remove a Department from a 
Location if an Employee is still assigned to that Location/Department combination. After adding 
and editing locations and departments, they may not immediately be available on the drop-down 
menu on the Employee Detail Screen. While on the Employee Detail Screen, click the "X" below 
the Gradience logo in the upper-right corner. Then, return to the Employee Detail Screen and the 
new location/department should be available.   



Setting up Global Preferences        

Global Preferences allow you to control your default program settings, such as Company Info, 
Report Options and specific program options.  
  

See below for detailed information on each tab. 



Company Info Tab  

The Company Information screen allows you to enter your company name, address and logo. We 
recommend entering the company name and logo because these will print out on Reports.  
Feature Description 
Company 
Name 

(Recommended) This will display on the report heading.  

Address, 
City, 
State, ZIP 
and 
County 

(Optional)  

Remove 
Current 
Logo 

This allows you to unselect the current logo. 

Assign 
New Logo 

This allows you to select a new logo. This logo will display on the top left of reports. 

Save 
Logo to 
disk 

This allows you to save the current logo to disk or to your hard drive.  

   



Editing Company Info 

Follow these instructions to edit the company info: 
1. Click Settings, Global Preferences. Enter information as needed. 
2. Click Save.  

   



Adding a Company Logo 

If you have your company logo available in a bitmap (. bmp) or jpeg (.jpg) file format, you can 
have this logo appear on reports. Gradience supports .bmp and .jpg file formats not to exceed 
200 x 200 pixels in size. The logo will appear in the top left when you print a report. 
   

To add a company logo, follow these steps: 
1. Click Assign New Logo.  
2. Navigate to the directory where the company logo is stored. It can be in a .bmp or .jpg 

format no bigger than 200 x 200 pixels in size.  
3. Click on the logo and then click on Open to select it.  
4. Click the Save button.  

   



Saving Logo to Disk 

You may save the logo to a directory on a disk or hard drive. When you add a logo within 
Gradience, the logo is actually saved within the database file.  
   



General Settings Tab 

The General Settings screen allows you to enter the default hours in a day that employees will be 
assigned, and allows use of the Forgotten Password Utility. This screen also allows settings for 
Forced Writes to Firebird and prompting to backup on exit.  
   

Feature  Description 
Epoch 
Setting 

We strongly recommend keeping the default settings. This setting will allow the Gradience program 
to appropriately interpret any two-digit year entered that is between 1920 and 2019. For example, 
with the default Epoch setting of 1920: 

• If you enter a date (such as in the Hire Date field) of 03/05/01, the program will interpret this as 
03/05/2001. 

Note: If you need to enter a year before 1920 or after 2019 in a date field within the program, you 
may enter the year as a four-digit number.  

Default 
Hours in 
a Day 

These are the default hours that will be assigned when creating a new employee. The Day Hours on 
the Employee Detail screen will be filled in automatically with these default hours when a new 
employee is created.  

National 
ID 
Number 
Format 
/Label 

Selecting one of these options will allow you to set the mask for the National ID Number Format. The 
default mask is set to the USA SSN format. With this selected, whenever you enter a new employee, 
the dashes automatically will come up in the xxx-xx-xxxx format. The label is the title that will appear 
on the Employee Detail screen. 

   

Feature Description 
Allow use 
of 
Forgotten 
Password 
Utility 

This option allows access to a utility that can be used, only with assistance from Tech Support, to 
gain access into the Gradience program. Call Tech Support if you have forgotten or lost your 
Gradience password. 

   
Forced 
Writes for 
Interbase 

•  If running the Gradience database on a Standalone computer, this option will help to keep the 
database more stable. A Workstation is more prone to lock up or crash than a Server. If the 
Gradience database is installed on a Workstation and the program is open at the time the 
computer locks up or crashes, the database is prone to becoming corrupt and possibly 
irreparable. A computer lockup or crash can be attributed to several things, including having 
too many programs open at the same time than what your computer memory can handle.  

• If the database is installed on a Workstation or Standalone computer, we recommend keeping 
this option checked. The performance may lag a little, but unless you have more than 800 
employees, you may not even notice it. We also recommend having a current backup, created 
within Gradience or DB Monitor, available. If the database is installed on a Server, normally a 
backup of the whole Server is created on a daily or regular basis. We still recommend setting 
up Scheduled backups within DB Monitor, but having this option checked is not as important 
on a Server. 

  

Prompt 
for 
backup on 
Exit  

This option allows you to turn on or off the message prompting for backup when you close out of the 
program. Backups are very important. We recommend that you turn this feature off only if you have 
scheduled backups within the DB Monitor.  



Report Options Tab 

The Report Options settings affect how reports will appear by default.  
Feature Description 
Print 
Preview  

Toggles (turns on and off) showing preview first before printing 

Header 
Bold  

Toggles bolding for Header Title 

Header 
Line  

Toggles putting a line under the Header Title 

Header 
Shade  

Toggles shading for Location or Department title row 

Data 
Line 

Toggles lines to separate data information 

Print 
SSN 

Toggles ability to show Social Security Numbers  

Print 
Picture  

Toggles ability to print Picture on printout 

Print 
Totals  

Toggles whether Totals show up on reports 

   



Editing Report Options 

To Edit Report Options, follow these steps: 
1. Choose an option by clicking in the box.  
2. ClickSave.  

   



Attendance Tab 

The Attendance Tab will show only if Attendance is installed. 
   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



Adding Employees       

You may get to the Employee Detail Feature by selecting Employee Detail under the Feature 
Column. 
   

All employees are entered through the Employee Detail screen. From here, you can enter their 
names, Social Security Numbers (optional), Hire Dates, Job Titles, and other pertinent 
information. This information is shared among Gradience Attendance, Records and TimeClock. 
This means that when you enter this information in one program, you’ll be able to see it in the 
other Gradience programs. 
   



Required Fields 

The following fields are required: First Name, Last Name, Hire Date, Work Status, 
Employment Status, Location, Department and Day Hours. SSN is not required in Gradience, 
but may be required when exporting Timecard Runs for certain payroll programs. 
   

To add a new employee, click New. (See Required Fields.) Click Save after entering employee 
information.  
  

Note: Locations and departments must be set up before entering new employees. (See 
Locations/Departments to set these up.) 
   



Reminders 
   

The Reminders feature will show you all open (unresolved) reminders and allow you to create, 
delete and resolve reminders. If you have created a reminder, it will show up when you first open 
the program, starting on the reminder date. Reminders will continue to display until you click 
Resolved.  
   

Reminders Tool Bar and Pane Layout 
       

Tool Bar: 
First — Prior — Next — Last arrows – Navigates through selected reminders 

New – Creates a new reminder 
Edit – Allows you to make changes to a reminder 

Save – Saves reminder 
Cancel – Cancels current changes 

Delete – Deletes selected reminder 
Print – Lets you print the Reminders report for selected employees 
Help – Brings up help for this screen 

   

Pane Layout: 
Reminder Date – Date reminder should first display 
Title – Heading of reminder 

Resolved – Checkbox displays checked for resolved or unchecked for open (unresolved) 
Employee Name – Displays name of employee that reminder is associated with 

User – Displays name of user that reminder will display for 
Description – The purpose of the reminder shows here 

   

Filters: 
User – Allows you to view reminders associated with specific users (must have access to 
Reminders, Assign Users under User Security) 
Show Resolved – Displays Resolved reminders only 

Show Unresolved – Displays Unresolved (open) reminders only 
   

Creating a New Reminder 
   

There are two types of reminders in Gradience:  

• One Time Reminders – These are reminders that are meant only to remind you of a one-
time event, such as: 
• Filing an Absence Report at the end of the year.  

• Recurring Reminders – These remind you of the following recurring events:  
• Anniversaries (Gradience Attendance) 
• Birthdays, Performance Reviews, and I-9 Renewals (available if Gradience Records is 
also installed) 

   

Setting a Reminder 
   

One-Time Reminder: 
1. Click on Reminders from the Features Column.  
2. Click New.  
3. Select (check) One-Time Reminder.  
4. Enter a Title and Reminder Date 



5. If you want the reminder to be associated with specific employees, select the checkbox, 
“Assign to all selected (checked) employees.” This is optional and will create a separate 
reminder that is associated with each employee.  

6. If you selected the checkbox in Step 5, you will need to select (check) any employees this 
reminder is about in the Employee Select Column. Otherwise, skip to the next step.  

7. By default, the User’s name will default to the login that was used to enter the program. 
Change this if you want the reminder to come up for another user, or you may select 
Global, which allows the reminder to come up for all users logging in.  
Note: You must have access to Reminders, Assign Users and Reminders, Assign Global 
under User Security to be able to change this option.  

8. Enter a description of the reminder, if needed. 
9. Click Save. 

Recurring Reminder 
1. To create a recurring reminder, follow these steps: 
2. Select Reminders from the feature list. 
3. Click New. 
4. Select (check) Recurring Reminder. 
5. Select the type of reminder: Anniversary, Birthday, Performance Review or I-9 

Renewal. 
6. Select a Through Date (when do you want to stop the reminder from occurring). 
7. Select how many days you want to be reminded before the event. 
8. By default, the User’s name will default to the login that was used to enter the program. 

Change this if you want the reminder to come up for another user, or you may select 
Global, which allows the reminder to come up for all users logging in.  
Note: You must have access to Reminders, Assign Users and Reminders, Assign Global 
under User Security to be able to change this option. 

9. Enter a description of the reminder, if needed. 
10. Click Save. 

Deleting Reminders 
   

Reminders are deleted from the Main Reminders screen by clicking on the Delete icon.  
   

Editing Reminders 
   

There are two ways to edit reminders:  
1. Main Reminders screen - From the main Reminders screen, you can edit the following 

columns just by clicking in the field: Reminder Date, Title, Resolved and Description. 
2. Edit Reminders screen - Clicking on Edit from the main Reminders screen will bring up 

the Edit Reminder screen. You also may double-click on the title of a reminder. The Edit 
Reminders screen allows you to change the Title, Reminder Date, User and Description. 

Note: If you need to change the Employee Name this reminder is about, you’ll need to delete 

the reminder and then recreate it.  

   

Open Reminders 
   

Open reminders will appear for the user they are assigned unless the Global option is checked. If 
a reminder is marked with Global, then it will show for all users. You may view open reminders by 
opening the program or selecting Reminders from the feature list.  
   
Note: If you have security access to “Reminders, Assign Users” (see User Security), you may 
view reminders set up by other users. You also may resolve reminders from the Open Reminders 
screen.  



   

   
   
   
   

   
   
   



Setting Up Absence Categories   

  
To access the Absence Category screen, go to Settings > Absence Category Maintenance.  
   

The Absence Category Maintenance screen allows you to create categories and then assign 
Time-Off Plans to the category. An absence category (or absence category title) is a name or 
category heading. This is used to label the available categories of stored totals. You may have a 
category such as Vacation, Sick, Personal, PTO, etc. (See Time-Off Plans for information on 
setting up a Time-Off Plan.) You may have an unlimited amount of categories.  
   

Assigning a Time-Off Plan to the absence category allows accrued time and lost time to be 
shown under that category. For example, you have a category called Vacation, and assign an 
accrual plan called Vacation – Full-time to it. Remember that a category is a title, and a Time-Off 
Plan is the actual plan of how your time off policy works. When employees who are assigned to 
the Time-Off Plan called Vacation – Full-time, their accruals will appear under the category 
Vacation under the Total this Year Tab on the Calendar and Transactions screen. 



Setting Up Holidays 

To access Holidays, go to the Settings menu, then Company Holidays .  

Overview: 

This section allows you to designate the dates of specific company holidays on the calendar. 
Holidays that have not occurred will automatically apply to an employee when you enter them into 
the program. The Holiday will show as an H on the calendar. You may sort by the Holiday name 
or by date.  

Note: Holidays cannot be added or deleted for employees that have locked Gradience TimeClock 
Time Card Runs during the same date range. (For example, if you’re deleting a holiday and you 
have a Time Card Run that covers the same date, the program will not allow you to delete the 
holiday from those employees listed under the locked Time Card Run.) 

Adding Holidays: 

To enter a holiday, follow these steps:  

1. Click Settings from the main menu and select Company Holidays.  
2. Click New to add a company holiday.  
3. Enter the name of the holiday you wish to add.  
4. Press TAB on the keyboard, and enter the date of the holiday (mm/dd/yyyy) or click the 

drop-down arrow and navigate to the date.  
5. Select Full Day, ¾ Day, ½ Day, or ¼ Day for how much credit for this holiday will be given. 

This amount corresponds with the Day Hours block on the Employee Detail screen.  
6. Click Save.  

Deleting a Holiday:   

To delete a holiday, follow these steps:  

1. From the Company Holiday screen, click on the holiday you wish to remove.  
2. Click Delete.  
3. Click Yes to the Warning box. This will remove the holiday from all employee calendars.  

Editing a Holiday: 

Only the holiday name can be edited. If you need to change a holiday date, you’ll need to delete 
the holiday and then re-enter it. To edit an existing Holiday Name, follow these steps:  

1. From the Company Holiday screen, click on the holiday you wish to edit.  
2. Make the necessary changes.  
3. Click Save.  



Setting Up Absence Codes 

To access Absence Codes, go to Settings > Absence Code Maintenance.  

Overview: 

 Absence Codes are letters that are on the calendar to indicate an employee absence. It is 
important to assign your absence codes to the proper categories before marking any codes on 
the calendar.  

There are 22 absence codes. You may change the description of 21 of them. The description of 
Holiday (H code) may not be changed, but you may change the settings for “Count Against 
Perfect Attendance” and “Assigned Absence Category.” Each letter can be assigned to one of 
the absence categories, which are labeled in Global Preferences. Once an absence code is 
assigned to a category, whenever you put that absence code on the calendar, the time for the 
absence is shown in the Used column for that category.  

For example, absence code C–Complimentary Time is assigned to the Personal Category. When 
the absence code C is put on the calendar, the time will deduct from Used time in the Personal 
Category.  

 

To edit the Absence Code Description, follow these steps:  

1. Click in the Description box.  
2. Enter the new description.  
3. Click Save.  

To change the Absence Category, follow these steps: 

1. Click in the category box.  
2. Click on the drop-down arrow and select the appropriate category.  
3. Click Save.  



Setting up Attendance Code Sharing       

Gradience Attendance and TimeClock can be fully integrated. This means that absence codes 
(paid time off), such as Vacation that is entered into one program, will also be entered into the 
other automatically 
  
Example: Linda takes a vacation day; her supervisor enters this time into TimeClock so that she 
is paid for the day. With integration set up, this time will also show on the calendar in Attendance 
as a "V" — Paid Vacation Day  

  

Steps to follow: 
1. Click Settings > Global Preferences > TimeClock Tab. 
2. Under Attendance Code Sharing on the TimeClock tab, click Enable Code Sharing. 

 



  

Note: 
If you wish, you may also select Enable Hours Worked Transactions Relation if you are going 
to enter Hours Worked (W Code) on the calendar in Attendance. With this option selected, when 
a "W" is entered on the calendar, it will also be entered into TimeClock automatically. 
  
You set the default hours in a normal workday in Global Preferences. 

  
In the event that a "W" needs to have a value associated with it that is less than or greater than 
the default hours in a normal workday, you would need to: 

1. Right-click that particular "W" and select Absence Detail. 
2. Enter the amount of hours that should be associated with that "W" and then click Save. 



Set up Reason Codes  

(See Setting Up Reasons Codes for detailed information) 
After turning on the Attendance Code Sharing, the next step is to set up Reason Codes. You may 
already have Reason Codes set up; if so, go to the next step of setting up payroll code 
descriptions. Reason Codes allow you to select specific reasons when entering a manual time 
entry. Some examples of Reason Codes are: Vacation, Sick, Personal, Computer Down, 
Corrected Time Entry, etc.  
   

Example: Linda takes a vacation day, when the supervisor enters a manual entry in TimeClock to 
record the time off, the time is entered as eight hours and the reason code is Vacation.  

Feature Description 

Reason Codes Reason Codes are required reasons when changing a punch entry or entering a manual entry.  
Payroll Codes Payroll Codes are descriptions that will show on reports and are related to Reason Codes and 

Absence Codes. 
Related 
Attendance 
Absence Codes 

Related Absence Codes will allow absences that are entered on the Calendar screen to also be 
reported in TimeClock.  

   
   

To set up Reason Codes, go to Settings > Reason Codes. 
   

Whether correcting an entry or entering time for someone out on vacation, entering a manual 
punch requires a reason. The three types of reasons are: Punch Changes (making a change to a 
punch time entry), Manual time entries (entering a time entry for eight hours Vacation, etc.), and 
Deleted time entries.  
   
The Reason Code window can be broken down into three parts: Reason Code, Payroll Code 
Description, and Related Attendance Absence Code.  
   
   
   



Set up Payroll Code Descriptions and Numbers 

(See Set Up Payroll Code Descriptions for detailed information.) 
A Payroll Code Description is related to a Reason Code and Absence Code. The Payroll Code is 
the description that will show up on reports (such as the Timecard Runs report).  
   
Example: A Reason Code of Vacation is set up. When someone takes a vacation day, a manual 
entry (from the TimeClock Entries screen) is created and given the Reason of Vacation. A 
Payroll Code Description of Paid Vacation is set up relating it to the Reason Code (Vacation). 
When a timecard report is run, it will show the Payroll Code Description of Paid Vacation (the 
Payroll Code is what will appear on reports). When that manual entry with the Vacation Reason 
Code is created, it also will create an entry on the Calendar in Gradience Attendance under the 
V- Paid Vacation absence code.  
   



Set up Payroll Description Columns for Reports 

When running a report, such as the Timecard Runs report, only two payroll descriptions will show, 
along with Regular Hours and Overtime hours, due to space constraints. If there are any other 
payroll code descriptions, they will show up in the Other Column. The Timecard Runs (Extended) 
report will show all payroll descriptions in a column format.  
   
After setting up the Payroll Code Descriptions, you’ll be able to set up which two payroll codes 
you’ll want to see, in addition to Regular Hours and Overtime Hours; time for all other payroll 
codes will be combined into the Other Column.  
   

To set up the two Payroll Description Columns, follow these steps: 
1. Go to Settings > Global Preferences > TimeClock Tab. Payroll Description Columns 

for Reports, locate First Column and Second Column. 
2. Click on the drop-down arrow for First Column and select which payroll code you’d like to 

show up on the Time Card Runs report.  
3. Then click on the drop-down arrow for Second Column and select another payroll code. 
4. Click Save. 

  
   



Set up Attendance Absence Codes 

Once the Attendance Integration is enabled, you’ll be able to relate Reason Codes in TimeClock 
to Absence Codes in Attendance. When you enter an Absence Code onto the Calendar that is 
related to a Reason Code, this will create an entry in TimeClock.  
   
Example: We have a Reason Code of Vacation = Payroll Code Description of Paid Vacation = 
Related Attendance Absence Code of V – Paid Vacation; when entering a V Code on the 
Calendar of eight hours, this time will automatically be entered in TimeClock as eight hours of 
Vacation (Reason Code). And this time will be shown on the Time Card Run report as eight 
hours of Paid Vacation(Payroll Code Description). 
   
   

With code sharing set up, this is how it will work: 
   
From the Calendar screen, we enter a V –  Paid Vacation day (Related Absence Code) on June 
5, 2007. 
   

From the TimeClock Entries screen, we can see it reports the time as Paid Vacation (Payroll 
Code Description).  
   

If we double-click on the Changed By Date at the bottom of the TimeClock Entries screen, we can 
see Vacation as the Reason for Change (Reason Code). 
   

It shows our columns of Paid Vacation (First Column) and Paid Personal (Second Column) with 
16 hours of Paid Vacation showing for Neil Adams.  
   

And it will work the opposite way; if we enter a manual entry in TimeClock, it will display in 
Attendance. 
   



Security Options 

Due to the confidential nature of information stored in Attendance, security is always turned on. 
This will help prevent unauthorized persons from accessing critical employee data. The use of 
security is required, and setting up access to Attendance and any other Gradience programs you 
have, should be the second thing you do. The first thing you should do (after changing the 
Administrator password) is set up Locations and Departments.To view the setup tasks you should 
perform, and the order in which they should be performed, click Help > Checklist from the main 
menu.  

You may set up access for managers to view only their departments and/or view specific 
employees from other departments. You may also set up employees to have read-only access to 
their records.  

Encrypt Data feature 

Gradience Attendance contains a Global Preference > General Settings button called Encrypt 

Data. By clicking Encrypt Data and entering the secret key of your choice, sensitive information 
such as Social Security Numbers can be encrypted in the HRWARE database. This feature can 
help prevent the casual viewing of Social Security numbers by unauthorized persons.  

To decrypt your data, simply navigate back to the General Settings and click Decrypt Data. Your 
data will no longer be encrypted.  



User Security - Detail Tab 

Features common to Gradience Records, Attendance, TimeClock and COBRA 

• Search For – This allows you to search by User Name.  
• Save As – This allows you to create additional users based on the access rights of another 

user.  
• Employee Record Access – This allows access to view, add or delete employee records.  
• Employee Detail – This grants access to the Employee Detail screen.  
• View SSN – This allows access to view Social Security Numbers.  
• Run Reports – This allows access to run reports.  
• Reminders – This allows access to add and delete reminders.  
• Reminders, Assign Global – This allows access to assign reminders as Global.  
• Reminders, Assign Users – This allows access to assign reminders to other users.  
• User Security – This allows access to add, edit, and delete users and user access.  
• Location/Department Maint – This allows access to assign location /department access 

for users.  
• Global Preferences – This allows access to edit global preferences.  
• Database Monitor – This allows access to the DB Monitor.  
• Database Backup – This allows access to Backup from the DB Monitor only.  
• Database Restore – This allows access to Restore from the DB Monitor. 
• Alter Product License – This allows access to enter a product key to change a license.   
• Product License. Conversion – This allows access to run the Conversion Utility.  
• Custom Reports – This allows access to create/modify Reports.  
• Import Data – This allows access to import employee data into the database.  
• Export Data – This allows access to export employee data.  
• Guest Users – This allows access to connect to the database via a third-party ODBC 

driver.  

Setting Access 

Setting up access to common features (Detail Tab).  

1. From the User Security screen, click Detail>New.  
2. Enter a Log In and Password (letters and numbers only) and the user’s Full Name.  
3. Select options for Displaying Reminder Alarms and Hints for this login.  
4. Select Yes to "Is User Active" to allow the user to begin logging in after giving access. 

Setting this option to No is a good security measure when users are out of the office for a 
number of days.  

5. Select what type of Feature Access users will have by clicking in the Access Rights field.  
6. Clicking on the arrow will allow you to select from the following:  

NO ACCESS – no access to selected feature  
READ ONLY – allows user to view only, cannot make any changes  
READ WRITE – allows user to view, add, and edit; no deleting allowed  
READ WRITE DELETE – allows user full editing rights to feature  
YES – allows access to feature  
NO – no access to feature  

7. Click Save.  

Program Specific Features: 

Attendance: 



• Year in Review – Allows user to view this features and print Year in Review reports.  
• Category Assignments – Allows user to view and edit Time-Off Plan assignments under 

Category Assignments.  
• Planner– Allows user to view and print reports.  
• Transactions– Allows user to view, edit and print transactions using the Transactions 

feature.  
• Absence Code Maintenance – Allows user to view and edit Absence Codes.  
• Time-Off Plan Maintenance – Allows user to view and create Time-Off Plan settings.  
• Absence Notes – Allows user to view, edit and print absence notes and attachments.  
• Holiday Maintenance – Allows user to add/delete/edit Holidays.  
• Modify Initial Balances – Allows user to add/delete/edit Initial Balances in the Category 

Assignment feature.  
• Calendar– Allows user access to the Calendar screen and to add/edit employee 

absences.  
• Absence Category Maint – Allows a user to create/edit category titles and assign Time-

Off Plans. Category Title examples: Vacation, Personal or Sick Time.  
• Perform Accrual – Allows user to access the Perform Accruals screen under 

File/Maintenance Menu to accrue time according to the assigned Time-Off Plans.  
• Transaction Utility – Allows user to access the Remove Transactions screen under 

File/Maintenance and remove unwanted accrual balances, as well as reset the Last 
Accrual Date.  

• Import Hours Worked – Allows the user to import hours worked data (W codes) for 
employees.  

• Scheduler– Allows the user access to the Scheduler feature.  



User Security - Locations and Departments 

You should have already set up your Location and Department names (see Locations and 
Departments). Now you will want to set up users’ access to the Locations and Departments by 
following these steps:  

1. Click on Location/Department tab from Settings > User Security > Detail.  
2. Click on the “+” (plus sign) next to Locations/Departments and next to the location and 

department name to expand the list.  
3. Click in the check box next to the location and department name to select access to these 

areas or individual employees within these departments. This will put a checkmark in the 
box. Click in the box again to de-select (or clear) the item.  

4. If you have already entered your employees in the program and assigned location and 
departments to them, when you expand a department, you will see all the employees 
assigned to that location/department combination. You may then select access to 
individual employees at this point by clicking in the box next to the employee.  
 
Note: If you have not yet entered your employees (through the Employee Detail feature 
or Import Data under the File Menu) into the program, you will still be able to assign 
access to a location/department combination, just not down to the employee level. You 
may later assign access down to the employee level after you enter your employees and 
assign a location/department to them. 
 
 

5. Click Save.  



Managing Employee Records 

This chapter will help you become acquainted with the program layout and how to enter 
employee information. Throughout this chapter, there are examples of different program screens. 
You may wish to view the sample database to get a better picture of how employee records look 
once entered. 

Make sure you have gathered the following information for each employee before attempting to 
enter employee records: 

• Social Security Number 
• Name (First, Middle, Last)* 
• Employee Identification Number 
• Date of Hire* 
• Job Title 
• How many hours in a normal day the employee works* 
• Location* 
• Department* 
• Full or Part Time* 
• Active, Inactive or Terminated Status* 
• Time-Off Plan (Vacation, Sick, Personal, etc.)* 

 

* Required fields 



Using Gradience Attendance 

  

Gradience Attendance is now easier to navigate and use than ever before. Even better, if 

you have other Gradience software installed, such asGradience Records andGradience 

TimeClock, you have access to all programs and features from one convenient place. 

 

The main parts of the Gradience user place are theMenu Bar,Program Bar,Feature 

Column,Employee Select Column,Selected Feature Paneand theRecent Features 

Pane. 

If you have not already read about how Gradience programs work and behave, please 

read the Getting Started topic for information which will save you time and effort! 



The Menu Bar 

File Menu: 

Maintenance> 

• PerformAccruals– This allows the program to accrue time according to your Time-Off 
Policies as defined under Settings/Time-Off Plan Maintenance. 

• RemoveTransactions– This allows you to remove transactions before re-running 
accruals. 

• BackupDatabase– This lets you perform a database backup while running the program. 
 
 

• Import Data– Imports basic employee data into the Gradience database. 
• Export Data– Exports basic employee data from the Gradience database. (SeeImport and 

Export) 
• Delete Employee– Deletes an employee from the Browse or Employee Detail 

screens.Note:This cannot be undone and deletes all data for the selected employee! 
• Import WorkedHours– Imports hours worked from a Tab-delimited file (SSN, Date 

Worked, Amount of Hours Worked). (See Import Worked Hours). 
• Exit 
• MRU (Most Recently Used) list– Allows you to quickly select an employee by clicking on 

his or her name. 

View Menu:  

• Filter Page– Gives other options for sorting and filtering, such as hiding terminated or 
inactive employees. 

• Open Reminders– Brings up all open reminders (those not checked as resolved) 
• Checklist– Displays Checklist screen that helps you set up the program 

Settings Menu:  

• User Security- Allows configuration of Attendance-specific User Security items. 
• Global Preferences- Allows configuration of global preferences for any installed 

Gradience program. 
• Guest Users- Allows for configuration of Guest Users. 
• Locations / Departments- Provides access to Locations and Departments maintenance 

window. 
• Time-Off Plan Maintenance- Configure Time-Off Plans using this window. 
• Absence Category Maintenance- Allows for maintenance of Absence Category details. 
• Absence Code Maintenance- Allows for maintenance of Absence Codes. 
• Company Holidays- Provides workspace for specifying Company Holidays. 

Reports Menu: 

Previews and prints up to 22 reports and charts, as listed below: 

 

Reports 



Attendance Detail 

Attendance Report 

Employee Summary 

Employee Balance 

Employee Anniversary 

Perfect Attendance 

Absence Detail 

Absence Notes 

Scheduler Report 

Bank Report 

Group Absences by Type 

Worked Hours 

Planner 

Transaction Detail 

Year in Review 

Adjustments 

Reminders 

 

Charts 
Absence Over Time 

Absence By Type 

Location Comparison 

Department Comparison 

Table Listings 

 

You can also print or preview table information by selecting the Table Listings menu 

item. 

 

Note:you can also access this list and select a report by clickingReportson the 

leftFeature Column. 



The Program Bar 
The Program Button in the upper-left corner allows you to select the Gradience program you 
wish to use and displays its features in the Feature Column. 
 
The programs are color coded as follows: 
 
Gradience Attendance 2008 –Green 
GradienceRecords 2008 –Red 
Gradience TimeClock 2008 –Purple 
  

  



The Feature Column 
 
 

TheFeature Column allows you to select which feature will be displayed in the Feature Pane on 
the right side. To make it easier, we also color-coded the features of each program. For example, 
if you select Gradience Attendance, and select Employee Detail from the feature column, you 
will see a green title bar. 
The Employee Select Column 
The Employee Select Column allows you to select or find employees quickly and easily, as well 
as select multiple employees for printing reports. 
Browse mode allows you to perform an incremental search for an employee, move columns and 
sort quickly. 
An incremental search allows you to enter the first couple of letters of the employees’ last name 
and will go to the first employee which matches those letters; and as you enter more letters, the 
search will become more defined. For example, if you enter the letter “A” in the Search field, the 
employee list will select the first employee name which starts with the letter “A.” If you enter the 
letter “d,” so that now you have “Ad” it will bring up the first employee name which starts with Ad, 
such as Adams. 
You may move columns according to your preferences. To move a column, click and drag the title 
to the left or right. Double arrows pointing inward will show you where you will drop the title if you 
release the mouse button. 
Sorting fields is just as easy. Just click on the title of the column you want to sort. For example, if 
you wanted to sort by first name, you would click on the First Name title. You can also set 
multiple sorts by holding the CTRL key and clicking on fields - the sort priority will be displayed 
above the field names. 
Tree View mode allows you to find or select employees by location and department. For 
example, if you were looking for employees who are under the Ft. Lauderdale location / 
Merchandising department, Tree View mode could show you at a glance. 
Tip: In Tree View, by default all locations and departments are unchecked. A quick way to select 
just one department is to click on the name of the department. This will select all employees 
under that department. Likewise, in Browse mode, you can select or deselect all employees by 
clicking on the red checkmark at the top left. 
Selected Feature Pane 
The Feature Pane is where the selected feature of the program will be displayed.  
  
Note: Columns can be resized. To resize a column, move your cursor to the left or right edge of 
the column until your cursor turns into a double arrow pointing left and right; click and drag your 
left mouse button to the desired width and release. The Employee Select Column can also be 
hidden and unhidden by clicking on the minus or plus sign in the top right corner. 



Elements of the Calendar Screen 
 

 

You will likely use this screen more than any other because it is where you enter 

absences and notes. Here is an overview: 

Absence Codes– To place an absence, you will first select one of the tools for the length 

of the day and then, select the code from the list below and place it on the calendar for the 

selected employee. 

Calendar Screen Tools: 

• FullDay– Sets the amount of hours taken for an absence to the normal day hours (usually 
8 hours for a Full-Time employee). Normal day hours are taken from the Detail screen. 

• ¾Day– Sets the amount of hours taken for an absence to ¾ of the normal day hours 
(usually 6 hours). 

• ½Day– Sets the amount of hours taken for an absence to ½ of the normal day hours 
(usually 4 hours). 

• ¼Day– Sets the amount of hours taken for an absence to ¼ of the normal day hours 
(usually 2 hours). 

• Erase– Allows you to delete absences from the calendar. 
• Select– Clicking on Select allows you to enter notes on a specific day without entering an 

absence. 
• Today– Changes the calendar to the current day. 
• Save– Saves current changes. If you select another employee, changes will be saved 

automatically. 
• Cancel– Cancels current changes. 
• Show Hours Worked– This feature allows you to toggle the display for Hours Worked on 

the calendar. Hours Worked is time entered on the calendar with a “W” code or from the 
day’s totaled Gradience TimeClock entries. 

• Show Absences– Allows you to toggle the display for absences on the calendar. 
Absences are time entered on the Calendar with any of the absences (A – V) code. 

EmployeeBalance Tabs: 

Total This Year Tab– This shows the employee’s current benefit year totals. 

Notes Tab– This allows you to enter comments for a specific day: you may also attach 

any file to the notes field. 

Year Settings Tab- This shows assigned Time-Off Plans (tables). 

Note:Negative balances will show in yellow. As well, realize that absence codes entered 

on future calendar months will affect employee balances negatively because accruals will 

likely not have been run for future months. 

Totals Since Hired Tab– Shows total balance since the employee was hired. 



The following symbols may be seen within calendar days: 

Magnifying Glass– This denotes partial day absences or that there are multiple absence 

codes places for that day. For example, if an employee is set up with eight hours (as set 

up on the Detail screen – Day Hours), the magnifying glass icon would be displayed 

when any single absence posted on the calendar was less than eight hours. 

Asterisk– This denotes a note or comment on this day. After selecting the day, click on 

the Notes Tab to view the note. 

Recording Absences 

Follow these steps to record an absence for an employee, such as vacation: 

1. Select an employee. 

2. Select the desired month of the calendar, if necessary, by using the arrows on either 

side of the calendar. Arrows on the top left side of the calendar change the month. 

Arrows on the top right side change the year. This will be the month the employee 

takes an absence. 

3. Using the mouse, click an absence code from the Absence List so that it is 

highlighted, then click a date on the calendar. Notice that the Full Day option is 

selected (above the calendar). This is the default setting when selecting an absence. 

To choose a different day increment, choose from ¼ day, ¾ day, or ½ day at the 

top of the calendar before selecting an absence. 

Note: As you add absence codes to the calendar, the time is automatically deducted on 

the Totals Tab. For example, if you select the absence code “V” and click on the 

Calendar, a full day is automatically deducted from the Used Vacation time under the 

Total This Year Tab. The full day assignment is set from the Day Hours block on the 

Employee Detail screen. 



Adding New Employees 
  

The Employee Detail screen allows you to add new employees, and view and edit existing 
employee records. 
Note:Before adding new employees for the first time, follow the checklist to set things up in the 
proper order. 
 
Follow these steps to add a new employee to Gradience Attendance: 

1. Click the New icon. Enter at least the Required Fields. (You can use the TAB key to move 
from field to field or hold down the SHIFT key and press TAB to move back a field.) 

2. Required Fields: 
• First and Last Name 
• Hire Date – date employee was hired 
• Work Status – Full or Part Time 
• Employment Status – Active, Inactive, or Terminated 
• Location – Current location 
• Department – Current department 
• Hours (Day and Week) – This is the amount of hours an employee works or is 

considered absent for a typical workday and workweek. (For example, you could 
have Day: 8 hours and Week: 40 hours) When you put a full day absence onto the 
calendar, it pulls the hours from this field. These numbers are used as defaults 
when assigning codes to the calendar and when generating report totals. 

3. Assign a Time-Off Plan to an employee, follow these steps (this assumes you have 
already defined Absence Categories and Time-Off Plans): 

4. From Category Assignments, click on the Assigned Time-Off Plan column. This will 
bring up a drop-down arrow. 

5. Click on the drop-down arrow and select the appropriate Time-Off Plan. (SeeTime-Off Plan 
Maintenance.) 

6. Click Save. 



Deleting Employees 
 

 

To delete an employee follow these steps: 

1. First select the employee to be deleted. 

2. Click on File. 

3. Click on Delete Employee. 

 

To recover a previously deleted employee follow these steps: 

1. Click on View and select Filter Page. 

2. Hold Ctrl + Alt and press "X." Release them together. 

3. A new check box appears in the upper-right corner of the window 

4. Check the new Deleted box so that formerly deleted employees will now be 

visible. 



Adding an Employee Picture 

A photo gives you a visual image of an employee, their dependent(s) or emergency contact 
person(s). Photos are not required. We recommend you use a digital camera to take your photos 
and save the images in the industry standard JPEG (.JPG) picture format or Bitmap (.BMP) 
format. An image size of 200x200 pixels works best. If your picture is larger than this, the 
program will squeeze your larger picture into the displayed picture frame. If your digital camera 
has TWAIN support, you can import the picture right into Gradience using the Twain Import 
feature. 

To add an employee picture follow these steps: 

1. Click on the Employee Detail button. 
2. Select the employee you want to add a picture to. 
3. Click Edit Picture. 
4. Click Assign New Photo. 
5. Navigate to where the employee picture is. Select it and click Open. If your photo is larger 

than the recommended size (200x200 pixels), you may get a message that asks if you still 
want to assign the file. If you click Yes, the program will try to squeeze your larger picture 
into the frame, however, the larger size of the file will be maintained and may make the 
database larger quicker. 

6. Click OK. 

Twain Import 

The Twain Import feature allows you to import pictures directly from your twain compliant digital 
camera. You’ll need to install the software that came with your digital camera. To import a photo 
from your digital camera, follow these steps: 

1. First, you’ll need to make sure that your digital camera is twain compliant and that the 
software that came with your camera is installed on the same computer where you will run 
Gradience. 

2. Connect your digital camera to your computer. 
3. Open Gradience and navigate to the employee you want to add a picture to. 
4. Click on the Personal Contacts tab. 
5. Select the Photo tab and click on Twain Import. 
6. Click the Select Source button and then on your camera name. You may have one or two 

options available. 
1. [Camera Name] – This option allows you to take the picture and import it to 

Gradience. Go to Taking a Picture and Importing to Gradience below to continue 
instructions. 

2. Photos in [Camera Name] - This option will allow you to download and view the 
pictures on your camera’s disk if you’ve already taken pictures. Go to Downloading 
Pictures from Camera Disk below to continue instructions. 

A. Taking a Picture and Importing it into Gradience 

Continue following these steps from Step 6 (1) above: 

1. After selecting your camera as the source, click OK 



2. Click the Acquire Picture button and click Take Picture. The picture should show up on the 
Twain Import screen. 

3. Click OK to select the picture. 

Note:The instructions for selecting or downloading a picture may be different depending on your 
camera. 

  

B. Downloading Pictures from Camera Disk 

Continue following these steps from Step 6 (2) above: 

1. After selecting this option, click OK. 
2. Click the Download button to download the pictures to your computer. 
3. Select the picture you want to import then click Transfer. 
4. Click OK to select this picture. 

Note: The instructions for selecting or downloading a picture may be different depending on your 
camera. 

  

Save Photo to Disk 

All the pictures in Gradience are stored in the Gradience database (hrware.gdb). This option will 
allow you to save the picture to a different directory, if needed. 

To save an assigned photo to your computer, follow these steps: 

Note: The picture must be assigned to an employee before you can save it off to a different 
directory. 

1. Click Personal Contacts, then the Photo tab. 
2. Click Save Photo to Disk. 
3. Navigate to where you want to save the photo. 
4. Name the photo. 
5. Click OK. The picture can only be saved as a .bmp file. 



Category Assignments 

After setting up your company Time-Off Plans (see Time-Off Plan Maintenance), you’ll need to 
assign the Time-Off Plan(s) to each employee. Each Absence Category must be assigned a 
Time-Off Plan (at minimum “None”) or accruals will return errors. 

Here’s how to assign a Time-Off Plan: 
1. Click the Category Assignments Feature. Note: If you are setting up for the first time, there 

will be three (3) default Absence Categories shown (Vacation, Sick, Personal) along with 
the default Time-Off Plans that were set up in the Absence Category Maintenance (see 
Setting Up Absence Categories). 

2. To assign (or change) an Time-Off Plan, click in the field across from the Absence 
Category you would like to assign. For example, double-click in the Assigned Time-Off 
Plan block across from Vacation; this will bring up a drop-down list. 

3. Choose the Time-Off Plan to associate with the Absence Category. For example, choose 
the Full Time Vacation plan. This is the plan that will be associated with the category 
Vacation. Whenever an accrual is run, the accrued time, as set up in the Full Time 
Vacation plan, will be put into the Vacation field on the employee’s Calendar screen. 

4. Click Save. 
Note: All Absence Categories must have a Time-Off Plan assigned; at minimum the “None” plan 
should be assigned. For example, if you have a part-time employee that does not accrue any Sick 
or Personal time, you would assign the (None) Time-Off Plan to the Sick and Personal 
categories. 

  

Initial Balances 
  
An Initial Balance is a starting balance for an employee and should only be entered once. For 
example, an employee is transferred from another location and has five vacation days left. You 
may enter his Initial Balance of 5 days or 40 hours, depending on your program display settings 
of day or hours (see Global Preferences). An initial balance may also be where an employee 
receives a certain amount of vacation, sick or personal days when he or she is hired. 

  

Entering Initial Balances 
  

To enter an Initial Balance, follow these steps: 
1. From Category Assignments, click in the Initial Balance Earned field on the row of the 

selected category, such as theVacation row. 
2. Enter the amount of time in hours or days, depending on your setting in the Global 

Preferences. 
Note: When entering a negative balance to the Initial Used field, do not add the minus sign 
(-) to the amount. This column is automatically negative. 

3. Click in the Initial Date field and click on the drop-down arrow. 
4. Select the date of the Initial Balance. 
5. Click Save. 



Printing Reports 
 

 

There are two ways to print employee information: 1) from a selected feature’s print icon 

and 2) from the Reports menu, either from the pull down menu at the top or the Reports 

feature on the left. 

  

Printing from a Feature 

 

 

Each feature, such as Employee Detail, Category Assignments, Calendar, Year in 

Review, etc., has a Printer icon that allows you to print the report associated with that 

feature. For example, to print the Employee Detail report from the Employee Detail 

feature you would select an employee and click on the Printer icon. You do not need to 

click in the checkbox if you’re going to print only a single employee. To print the report 

for multiple employees, click the checkbox next to each employee name in the Employee 

Select Column, then click the Printer icon. 

  

Printing from the Reports Menus 

 

 

Reports selected using the top pull-down menu or the Reports feature in the Feature List 

appear in the right Feature Pane along with additional filters and options. You may print a 

report for a single employee or multiple employees. 

Tip: If you’re going to print a report for a whole department or location, you can use the 

Employee Select Column TreeView Mode to select quickly. 



Year In Review Report 

The Year In Review Report allows you to view selected absence categories in a calendar 

format. This report is similar to the Planner Report, except the Year In Review absence 

categories are mainly by dates. 

Additional options for this report: 

• From Date and Through Date– This allows you to select 
specific dates. 

• Date Range Used for Year to Date Totals: Report Date Range– allows you to view 
totals from a specific date range. This date range defaults to January through December of 
the current year. Date Range Assigned by Time-Off Plans allows you to view totals that 
reflect the Calendar screen. 

• Only Show Months With Activity– This allows you to view only months with absences. 
• Absence Categories– This allows you to choose which categories you want to view. 



Absences Tab 
 

 

Using theYear in Review tab, you can access Absences notes and go to the selected day in the 
main calendar. By default, the current year will be shown. To pick another date range, use the 
up/down arrows to scroll to the desired date. The letters on theYear in Review >Absence 
calendar are the absence codes that are on the main calendar. 

– This lets you enter notes on a specific day. An asterisk on the calendar denotes this. 

– This will take you to the selected day on the calendar. 

– A plus sign next to a code denotes more than one absence code on same day. 

– Letters on the calendar are the absence codes for specific days. 



Settings Tab 
 

 

The Year in Review > Settings tab gives you several options.  

• Only Show Months with Activity– Checking this option and then clicking back on the 
Absences Tab will show only months that have absences on the calendar. 

• View Absences Assigned to:– This option allows you to select only the absence 
categories you want to view on the Absences Tab. 

• Absence Code Reference List 
Sort – Absence Class or Absence Code 
This allows you to sort by Absence Class or Absence Code to quickly show the assigned 
absence category. For example, you may need to know that the code S – Suspensionis 
assigned to category None instead of category Personal. 



Transactions Screen 

The Transactions feature allows you to view employee balances in a checkbook-like 

journal. You also may enter time manually and edit existing time. To access it, click on 

the Transactions feature button. 

Adding a Transaction Entry 

To add a new entry, whether Earned or Used time, follow these steps: 

1. Click on the Category you want to add or deduct time from (for 

example,Vacation, 

Sick or Personal button.) 

2. From the Transactions Features pane, click on New. 

3. Click Yes. 

4. From the Edit Transaction window, enter the following: 

1. Transaction Date– Enter the date of the transaction. 

2. Transaction Type– (select one) 
• Adjustment to Earned – Select this option when you want to show a debited 

manual adjustment. The Transaction Detail report will show: “Adjustment to 
Earned,” which is credited (giving time). 

• Adjustment to Used – Select this option when you want to show a credited 
manual adjustment. The Transaction Detail report will show: “Adjustment to 
Used,” which is debited (deducting time). 

• Loss:Carry Over – Select this option if you want to show a manual carry 
over loss. The Transaction Detail report will show: Loss: Carry Over 
(deducting) of amount. A carry over loss happens at the end of a selected 
time period, usually at the end of a benefit year in which the employee is not 
allowed to carry over a specific amount of time. 

• Loss: Exceeded Max Balance – Select this option if you want to note 
exceeded time. The Transaction Detail report will show: Loss: Exceeded Max 
Balance. An exceeded max balance loss happens when an employee’s 
balance exceeds the Max Balance setting in the Time-Off Plans. 

• Time Earned – Select this option if you want to show earned time. The 
Transaction Detail report will show: Earned. This option is normally used if 
you enter all your time in manually. 

• Time Used (absence code) – Select this option if you want to show used 
time. The Transaction Detail report will show: Used: (absence code). You 
may either drag an absence code to the calendar or manually enter the used 
time through the Transactions Screen. 

5. Amount in (Days or Hours) – This will show Days or Hours, depending on your 

display setting in Global Preferences. Enter the amount of time to be earned or 

deducted. Note: Do not add a minus sign (-) to this field if you’re deducting time. 

Selecting a Loss or Used time above will automatically deduct the amount of time. 

6. Transaction Notes– Enter any comments related to this transaction. 

7. ClickSaveto keep this transaction or click Cancel to not keep it. 

Editing Transactions 



To Edit any transactions, follow these steps: 

1. Click on the Category you want. 

2. Click on the transaction that you want to edit. 

3. Click Edit. 

4. Click Yes. 

5. Make any changes necessary. 

6. Click Save to keep changes. 



Importing Worked Hours 
 

 

This feature allows you to import 'W' transactions (Worked Time) into the 
database. Please note:You must have entered your employees first. This will 
only import hours to existing employees. The worked time will also be posted into 
Gradience TimeClock if you have Code Sharing turned on. Follow these steps to 
import hours worked: 

Format a Tab delimited or fixed length text file with the following order: 
 

• SSN– ###-##-#### (11 characters long) or ID 
• Date– MM/DD/YYYY (10 characters long) 
• Amount– ##.## (5 characters long) 

 
 

Validate the file using a text editor like Notepad or Wordpad. 

Go to File > Import Hours Worked. 

Select the type of file (Fixed or Tab Delimited). 

Click Select to browse to your import file. 

Click Test to verify there are no errors associated with the file. 

Click Import to complete the process. 



Planner 
The Planner shows you how many absences have been marked on the calendar for each month 
by letter code. The difference between the Planner and the Year In Review is that the Planner 
shows absences mainly by the absence code. The Year In Review shows absences mainly by 
month. Otherwise, everything is the same. 

 
Printing Planner 
To print the Planner report, follow these steps: 

1. Click on the Reports menu, and select Planner. (Planner Report, for more details on the 
report interface). 

2. Select your report options and the employee(s) you want to report on. 
3. Select Preview, then the printer icon to print. 

 
 



Reminders 
The Reminders feature will show you all open (unresolved) reminders and allow you to create, 
delete and resolve reminders. If you have created a reminder it will show up when you first open 
the program, starting on the reminder date. Reminders will continue to display until you click 
Resolve. 

  

Reminders Tool Bar and Pane Layout 
  

Tool Bar: 

• First-Prior-Next-Last arrows– navigates through selected reminders 
• New– Creates a new reminder 
• Edit– Allows you to make changes to a reminder 
• Save– Saves reminder 
• Cancel– Cancels current changes 
• Delete– Deletes selected reminder 
• Print– Lets you print the Reminders report for selected employees 
• Help– Brings up help for this screen 

Pane Layout: 

• Reminder Date– Date reminder should first display 
• Title– Heading of reminder 
• Resolved– Checkbox displays checked for resolved or unchecked for open (unresolved) 
• Employee Name– Displays name of employee that reminder is associated with 
• User– Displays name of user that reminder will display for 
• Description– The purpose of the reminder shows here 

Filters: 

• User– Allows you to view reminders associated with specific users (must have access to 
Reminders, Assign Users under User Security) 

• Show Resolved– Displays Resolved reminders only 
• Show Unresolved– Displays Unresolved (open) reminders only 

Use Date Filters: 
The From Date and Through Date filters can be enabled here to show Reminders only for the 
selected date range. 

  

Creating a New Reminder 
There are two types of reminders in Gradience: 
One Time Reminders– These are reminders that are only meant to remind you of a one-time 

event, such as filing an Absence Report at the end of the year. 

Recurring Reminders–These remind you of the following recurring events: 

• Anniversaries (Gradience Attendance) 
• Birthdays, Performance Reviews, and I-9 Renewals (available if Gradience Records 2008 is 
also installed) 

  

Setting a Reminder 
One Time Reminder 

1. Click on Reminders from the Features Column. 
2. Click New.  
3. Select (check) One Time Reminder. 
4. Enter a Title and Reminder Date. 



5. If you want the reminder to be associated with specific employees, select the checkbox 
“Assign to all selected (checked) employees.” This is optional and will create a 
separate reminder that is associated with each employee. 

6. If you selected the checkbox in Step 5, you will need to select (check) any employees that 
this reminder is about in the Employee Select Column. Otherwise, skip to the next step. 

7. By default, the User’s name will default to the login that was used to enter the program. 
Change this if you want the reminder to come up for another user, or you may select 
Global which allows the reminder to come up for all users logging in.Note: You must have 
access to Reminders, Assign Users and Reminders, Assign Global under User Security to 
be able to change this option. 

8. Enter a description of the reminder, if needed. 
9. Click Save. 

Recurring Reminder 
1. To create a recurring reminder, follow these steps: 
2. Select Reminders from the feature list. 
3. Click New. 
4. Select (check) Recurring Reminder. 
5. Select the type of reminder: Anniversary, Birthday, I-9 Renew, or Performance Review. 
6. Select a Through Date (when do you want to stop the reminder from occurring). 
7. Select how many days you want to be reminded before the event. 
8. By default, the User’s name will default to the login that was used to enter the program. 

Change this if you want the reminder to come up for another user, or you may select 
Global, which allows the reminder to come up for all users logging in.Note: You must have 
access to Reminders, Assign Users and Reminders, Assign Global under User Security to 
be able to change this option. 

9. Enter a description of the reminder, if needed. 
10. Click Save. 

Deleting Reminders 
Reminders are deleted from the Main Reminders screen by clicking on the Delete icon. 

  

Editing Reminders 
There are two ways to edit reminders: 

1. Main Reminders screen -From the main Reminders screen you can edit the following 
columns just by clicking in the field: Reminder Date, Title, Resolved and Description. 

2. Edit Reminders screen -Clicking on Edit from the main Reminders screen will bring up 
the Edit Reminder screen. You may also double-click on the title of a reminder. The Edit 
Reminders screen allows you to change the Title, Reminder Date, User and Description. 

Note: If you need to change the Employee Name that this reminder is about, you’ll need to delete 
the reminder and then re-add it. 

  

Open Reminders 
Open reminders will appear for the user they are assigned unless the Global option is checked. If 
a reminder is marked with Global, then it will show for all users. You may view open reminders by 
opening the program or selecting Reminders from the feature list. 
Note: If you have security access to “Reminders, Assign Users” (SeeUserSecurity), you may 
view reminders set up by other users. You may also resolve reminders from the Open Reminders 
screen. 



Scheduler 

The Scheduler is a new feature that displays overlapping days off at a glance. You may 

view time off by department, location or specific employees. You may also view by 

specific absence codes. 

Viewing Time Off 

To view time off follow these steps: 

1. Select Scheduler. 

2. Select employees under the Employee Select column.Note: To quickly select a 

department or location, click the TreeView button under the Employee Select 

column. 

3. On the Schedule Tab, select the date range you wish to view and then click 

Refresh. We recommend selecting one or two months at time when viewing as 

selecting more months can slow performance when scrolling to the right. 

4. Select the Filters Tab if you want to view on specific absence codes. Click Refresh 

from the Schedule Tab to refresh the data. 

5. Clicking the Go to Calendar button will take you to the Calendar for the selected 

employee. 

Sorting 

Right-clicking anywhere on the Scheduler grid allows you to sort by: 

Name 

Title 

Location/Name 

Location/Title 

Department/Name 

Department/Title 

Location/Department/Name 

Location/Department/Title 

Note: A bullet next to the sort order designates the current sort. 

Moving and Resizing Columns in the Scheduler 



Moving Columns 

Moving a column allows you to view data more easily. To do so, simply click and drag 

the Title column heading left or right. An arrow displays where the column will be 

“dropped.” 

Resizing Columns 

Sometimes you may not be able to see all of the data in a column because another column 

is overlapping. To move the column, move your mouse pointer directly between two 

columns until you get the resize icon (two arrows pointing in opposite directions). Then 

click and drag with your left mouse button to the left or right. 



The Calendar Pane 
  
The Calendar Pane (select Calendar from the Features list) allows you to log absences and 
work time on the calendar, view employee totals, log notes onto specific days and search for 
employees in a quick, efficient manner. 

1. ¼, ½, ¾, Full Day– Use these in conjunction with the work time (W code) and absence 
codes to log time used and worked. 

2. Erase– To erase an entry, click on Erase and then click on the absence code on the 
calendar. 

3. Select– Click on Select when you want to add a note to a specific day. Clicking on Select 
allows you to click on the calendar without adding an absence code. 

4. Today– This selects the current day and month. 
5. Display Hours Worked– This allows you to toggle time worked codes on and off. 
6. Display Absences– This allows you to toggle absence codes on and off. 
7. Totals This Year– This shows current year totals. 
8. Totals Since Hired– This shows totals since employee was entered in the program. 
9. Notes– This allows you to put notes on specific days. To add a note, click on Select 

(above the calendar) and click on a date on the calendar; then click on the Notes Tab. An 
asterisk (*) will show on the calendar on the days with notes. Right-clicking brings up text 
editing and insert object options. 

10. Year Settings– This shows current year and Time-Off Plan settings. 



Assign Absence or Work-Time Codes to the Calendar 
To assign an absence or work-time code to the calendar, follow these steps: 

1. Click the Calendar feature from the Features list on the left. 
2. Select the employee you want from the Employee Select Column. 
3. Using the Absence Code List on the right, select the absence or work-time code you wish 

to record. For example, select V for Vacation. 
4. Using the buttons above the calendar, select the amount this code should apply to the total 

of hours used, for example, Full Day. 
Note: ¼, ½ or ¾, the program will calculate the appropriate amount of hours from the 
Hours field on the Employee Detail feature. 

5. Select the Calendar Month and Year using the arrows above the calendar. 
6. Click once on the date you wish to apply the absence or work-time to. Time will 

automatically be deducted on the totals (below the calendar). 



Absence Detail 
  

The Absence Details window allows you to edit partial and multiple absences. To access this, 
select the date on the calendar, then right-click and select Absence Detail. 

 
  

To enter time for an absence using the Absence Detail screen, follow these steps: 
1. Click on SELECT button above the calendar, then click on the day you wish to add an 

absence. 
2. Right-click on the calendar and select DETAIL. 
3. Click in the appropriate Hours block and enter the time in decimals down to .6 (1/100thof an 

hour). The Total Hours will show in decimals and hours along with the date. 
4. Click OK and click Save on the Calendar screen. 

Note: When entering time into the Absence Detail screen, the time must be entered in decimals. 
To keep things simple, you may want to round the time to 6-minute increments. 
  

Formula for converting minutes to decimals: minutes divided by 60. Minutes must be in 6 minute 
increments. 



Manual and Automatic Accruals 
  

An accrual (the amount of time off that has accrued for each employee) can be run manually or 
automatically. An automatic accrual occurs when the program is set to run an accrual on a daily 
or weekly basis depending on the Accrue Schedule settings under the Gradience Attendance 
Global Preferences Attendance Tab. 

  

Automatic Accrual 
  

For an automatic accrual to run, you must click on Global Preferences > Attendance. On the 
right, below the accrual schedule, click Run. Then, whenever the program is opened for the first 
time during that day according to the schedule, the program will accrue automatically. Time-off 
will not necessarily accrue to anyone. What will happen is the program will "calculate" whether or 
not to accrue Time-Off to anyone.   
  

For example, if your schedule is set only to Mondays, then every Monday when the program is 
first opened, the program will run an accrual. 
  

Note: We recommend running the first couple of accruals manually to make sure the Time-Off 

Plans are set up correctly. 

  

Manual Accrual 
A manual accrual occurs by clicking on the Run Accrual button when the Perform Accruals 
screen displays. The Perform Accruals screen will display when the program is first opened (if the 
Accrual Schedule is set up), or you may go to File, Maintenance, Perform Accrual. 

1. Go to File, Maintenance, Perform Accruals and click on Run Accrual. Click Cancel to abort 
running the accrual 

2. Once the accruals are finished, you have the option to preview, which allows you to see 
the current transactions that took place, or post accruals, which posts the transactions to 
the employee’s records. 

The Perform Accruals window allows you to run a manual accrual. This will accrue time, such as 
vacation, sick or personal time for employees according to their assigned Time-Off Plans. 

• Run Accrual –Clicking this button runs a manual accrual. The program will accrue your 
employee’s vacation, sick and personal time according to the Time-Off Plans you set up. 
(SeeTime-Off Plans.) The program will normally run an accrual starting one day after the 
last accrual date through today’s date. (For example, if the last accrual date was 
December 31, and an accrual was run on January 15, the program will accrue time for 
anybody that needed to be accrued within those dates (from January 1 through January 
15). January 15 will now become the last accrual date. The next time an accrual is run, it 
will accrue from January 16 through today’s date. 

• Cancel Run –This aborts the run. 
• Preview –This shows a print preview of accrued time. 
• Post Accruals –This posts the accrued time from the run to employee records. 

• Exit –This closes the screen. Note:If accrued time has not been posted, then clicking on 
Exit will also cancel the accrual run. 

• Accrual last performed on mm/dd/yyyy –This is the last accrual date. This denotes the 
last time an accrual (whether manual or automatic) was run. The next accrual will run from 
one day after the last accrual date to today’s date. 



 Advanced Options 
• Accrue Thru Date –This is an advanced feature, and normally you will only want to accrue 

through today’s date. This feature will allow you to accrue up to any date as long as it’s 
after the Last Accrual Date. The option Enter Custom Date under Accrue Through Date 
Options must be selected for this option to be available. 

• Accrue Through Today– This is the default that the program is set to and will accrue from 
the Last Accrual Date through today’s date. 

• Enter Custom Date– This option allows you to select any date to accrue through as long 
as it’s after the Last Accrual Date. (For Example, if the Last Accrual Date is December 31, 
and today’s date is January 15, the program will normally accrue from January 1 (one day 
after the Last Accrual Date) through January 15. With this option selected you may accrue 
through any date that is after December 31 – not just through January 15). 

• Report Group Settings –Once an accrual is run, you will have the option to Preview the 
accrued time. This allows you to make sure your time given is working correctly before 
posting. On the Preview you may sort by Location and Department to view the Accrual 
Summary report. 

• Export a report– When inside the Print Preview window, click the Export icon on the 
menu bar. This tool allows you to Export in one of the following formats: 

• RTF file 
• Excel table (OLE) 
• E-mail 
• Text (matrix printer) 
• PDF file 
• Excel table (XML) 
• JPEG image 
• BMP image 
• TIFF image 
• HTML file 

 
See Reports for more information. 



Remove Transactions 
  

To get to this screen, go to Settings, Maintenance, then Remove Transactions. This screen 
allows you to remove unwanted transactions and reset the last accrual date so that you may start 
accruing from a specific date. This is also suggested if you’ve just entered your employees and 
already set up your Time-Off Plans and you want to accrue from Jan. 1 of the current year or any 
other date. 

  

Removing Unwanted Transactions 
  

Use these instructions when removing unwanted transactions. This will allow you to remove all 
accruals (earned time & losses), adjustments, used time, or just certain categories.  
  
Note: Using the Remove Transactions Utility will not remove any Initial Balances. If you have 
entered Initial Balances, you will need to remove these manually from the Category Assignments 
screen. 

1. Create a backup before proceeding! (Back up and Restore.) 
2. Select a Begin Date – This will remove transactions starting from this date. This is also the 

date that the Last Accrual date will start from, if selected. 
3. Select an Ending Date – This will remove transactions up to, and including this date. (For 

example, enter 01/01/01 for the Beginning Date and today’s date for the Ending date.) 
4. Select one or more of the following: 

• Accruals – removes earned and lost time (but not adjustments). 
• Adjustments – removes manual adjustments (Adjustment to Earned or Used time). 
• Used – removes used time (but not adjustments) 
• Reset Last Accrual date – the Last Accrual Date is the date where the program will 

start accruing from. This allows you to reset the last accrual date to the Begin Date. 
(e.g., accruing from 01/01/01) 

• Remove Transactions for Active Employees only – will not remove transactions for 
Inactive or Terminated employees. 

• Remove Transactions applied to these categories: None, Vacation, Sick, Personal 
(you may have more than just these categories). 

• Click Run Process. 
Using the Transaction Utility does not run any accruals. You will need to run a manual accrual to 
accrue time. It will remove accruals according to the Begin and End date and reset the Last 
Accrual date to the Begin date. Before running an accrual, make sure your Time-Off Plans are set 
up correctly. (SeeSetting Up Time-Off Plans)  
  
Note: If you’re not sure which options to choose, use the defaults; these are the common 
settings. Select your Begin Date and End Date and click on Run Process. 

  

Resetting the Last Accrual date 
  
You may want to reset only the Last Accrual date. For example, you’ve just entered all your 
employees and want to begin accruing from Jan 1st. 
To reset the Last Accrual date, follow these steps: 

1. Deselect all options EXCEPT the reset last accrual date option. 
2. Enter your begin date. 
3. Enter your end date. 
4. Click Run Process. 

Using this process will NOT remove or run any accruals. It will only reset the last accrual date to 
the begin date. For example, if you selected 01/01/07 for your begin date and 06/31/07 for your 
end date, and checked only reset last accrual date, the program will reset the last accrual date to 



01/01/07. When you run an accrual, either manually or automatically, the program will start 
accruing from this date. The end date is not important, but it is required. You may have any end 
date that is equal to or after the begin date.  
  

Note:Before running the accruals, make sure your Time-Off Plans are set up. 

  
  



Time-Off Plans 
  

To set up a Time-Off Plan, we suggest becoming familiar with the following features first, then 
read the section on Setting Up a Time-Off Plan. 

• First – Prior – Next – Last– This allows you to scroll through the Time-Off Plans. 
• Delete– This deletes selected Time-Off Plan only if employees are not assigned to it. 
• New– This creates a new Time-Off Plan. 
• Save– This saves current Time-Off Plan settings. 
• Cancel– This cancels all changes. 
• Print– This prints the Time-Off Plan. 
• Browse– This allows you to view all Time-Off Plans in table format. 
• Detail– This allows you to view selected Time-Off Plan settings. 
• Time-Off Plan Name– This is the name of selected Time-Off Plan. 

  

Method 

• Time of Service– This allows you to accrue from hired date of employees. 
• Hours Worked– This allows you to accrue by hours worked. 

• Select the Benefit Year 
• Hire date– The "year" begins on the employee's anniversary. 
• On the 1st (Calendar)– The "year" begins on January 1st. 
• Fiscal Year– Accrues on Fiscal date (see Fiscal date in Global Preferences). 

• Select How Often to Accrue 
• Daily– Accrues an amount each day, 365 days a year (366 on leap years). 
• Weekly– Accrues 52 weeks a year beginning on the employees’ anniversary date. 
• Monthly– Accrues on a monthly basis (on hire date, on the 1st,or Fiscal date). 
• Yearly– Accrues yearly (on hire date, on the 1st, or Fiscal date). 
• Custom– Allows you to enter custom dates. 

  
Note:Custom dates do not roll over into the next year. For example, if you entered a custom date 
of March 15, 2001, you would need to manually enter a date for March 15, 2002, also, for the 
program to accrue the following year. The program will not automatically roll over dates to the 
following year. 

• Select what to do with prior year balance 
• Carryover balance from prior year– allows carry over (negative and positive) 
• Zero balance from prior year– zeros balance at end of benefit year 
• Zero balance each time earnings are applied– (for example, if Monthly was selected 

under How Often to Accrue, the balance would zero out on a monthly basis 
• Pro-rate earnings for partial months & partial years– Calculations of partial years or 

partial months can occur in some cases if the benefit year is set to “On the 1st” or “Fiscal 
Year”. In most cases pro-rate is not desirable. This option allows you to pro-rate. For 
example, if a new employee was hired on December 12thand your accrual tables were set 
up to accrue yearly on January 1st,this employee’s time would be credited with only from 
December 12ththrough January 1stif pro-rating was selected. It would be a partial amount. If 
the case was NO pro-rating, then the employee would receive the full amount as if he had 
been there for a full year. 

 Time earned in – This setting is how you will enter time into the Earning Levels: 

• Hours – This allows you to enter time in hours. 
• Days – This allows you to enter time in days. 
• Weeks – This allows you to enter time in weeks. 

Earning Levels Start on Benefit Year: This enables an employee to begin earning the next 
higher amount at the beginning of the year they reach his or her next level. 
  



Example: A person earns 40 hours of vacation per year every January 1, for the first five years 
and 80 hours per year from five to ten years of service. They reach their fifth anniversary in May 
of 2008. normally, they would not earn the new "higher" amount until the January that "follows" 
because the January "prior" to their anniversary, they had not yet been employed five years. With 
this feature checked, they would earn 80 hours on the January of the year of their fifth 
anniversary.  
  
Max Annual Bank: This option allows you to cap "accumulated carry over" at an amount that you 
enter. 
  
 Example: You may allow carry over (such as 5) in the Max Annual Carry, but may want 
to cap "accumulated carry over" (such as 20). Each year, the program would allow them to carry 
over 5, and then when this cap hits 20, it would stop carrying over. 
 

Earning Levels – 

• Level – Designates the row level (Press TAB to create a new level). 
• From Month – Designates starting month for the row. 
• Up To Month – Designates the month the benefit goes UP TO. 
• [Time] per Year – Shows how time is entered (Hours, Days, or Weeks). 

Max Balance Allowed – Allows you to set a specific maximum balance. Whenever this max is 
reached at anytime throughout the year, the program will deduct time to bring the balance 
down to this number. Note:On the transaction detail report, this time will show up as Loss: 
Maximum Balance 

Max Annual Earn – This allows you to set a specific maximum amount for 12 months. This 
means that the earnings cannot go over this amount within a 12 month period. Whenever 
this max is reached, the program will deduct time to bring the balance down to this number. 

Max Annual Carry – This allows you to set a specific maximum amount to carry over. This option 
will only allow up to this amount to be carried over from year to year on this level. Excess 
carry over will be deducted and shown on the transaction detail report as: Loss: Max Carry 
Over. 

Comments – Not required. Enter notes pertaining to selected Time-Off Plan. 



Frequently Asked Questions 

  

I don’t want the program to run accruals for me. I want to enter my time 
manually for each of my employees. Is there anything I need to setup? 
  

Most of our customers who want to enter their own earned time manually also want to zero out at 
the end of the year so that their balances start fresh. You can set up a Time-Off Plan that doesn’t 
give time (so that you can enter your time in manually) and will zero out your balances each year 
on December 31. This way, your employee balances start fresh each year. Or, you can do a 
manual offsetting adjustment through the Transactions Screen to zero out your own balances 
each year. 

  

Will my company policy fit into an Time-Off Plan? 
  
Because each company’s policy may be different, we can’t guarantee that our Time-Off Plans will 
work with every policy, but they will work with the majority. You also may use Remove 
Transactions to enter time manually and not use the program to accrue for you if you choose. Or 
you may edit, delete or manually enter Time-Off on the Transactions Screen. 

  

What should I do if my balances are incorrect? 
  

One of the major causes of erroneous balances is flawed Time-Off Plans. To help identify why 
your balances are incorrect. 

  

What is an accrual? 
  

An accrual is simply an accumulation of time units. Gradience Attendance can accumulate 
earnings and deductions to an employee’s balance of paid time off based on a Time-Off Plan 

  

What is a Time-Off Plan? 
  

A Time-Off Plan is a set of rules for the program to follow when accumulating or deducting time 
units from your employees’ balances. This is based on your company policy for time off. For 
example, you can set up a Time-Off Plan that will give 40 hours vacation time on January 1 for 
employees with less than five years, 80 hours vacation time for employees with more than 5 
years, and allow only a certain amount of carry over each year. 

  
What if I want to turn off the accrual request that appears each day when I 
enter the program? 
  

Click on Settings, Global Preferences, then select Attendance. Under Accrual Schedule, remove 
all the check marks from each day. Click SAVE to change the request, then Exit to close this 
menu or just set the Accrual Schedule to No Action. 

  

What if I ran the accruals by accident, can I remove them? 
  

Yes. Please seeRemoving Unwanted Transactionsfor details. 

  

What if I do not want to run accruals? 
  



Every employee must have an assigned Time-Off Plan for each absence category your company 
has. Remember that the absence categories are your buckets for your benefits (Vacation, Sick, 
Personal, PTO, etc.). On the Category Assignments screen, there cannot be any “blank” entries 
for Assigned Time-Off Plan. We provide the (None) benefit plan for this purpose. (SeeManually 
Entering Timefor setting up without using the program accrue feature.) 

  

What are Transactions? 
  

Transactions affect employee balances. They are like checkbook entries. The more deposits 
(earned time) you have, the higher your account balances. The more withdrawals (used time) you 
have, the lower your balance. There are transaction entries for each Time-Off category and each 
earned amount. 

  

How far back will Attendance calculate transactions? 
  

Attendance accrues only from the last accrual date. The last accrual date in the program will 
either be Jan 1 of the current year or the date of the last accrual run. However, you can always 
remove accruals and re-run them for any date range.  

  

How many Time-Off Plans do I need to set up? 
  

In determining how many benefit plans you should create, consider the following: 

• Does your company provide more than one category of time off? Gradience Attendance 
allows unlimited categories for each employee. We have included three default plans 
labeled Vacation, Sick and Personal. You may add your own, such as PTO, Birthday, 
Comp Time, etc. 

• Do you have separate Time-Off benefits for different employee categories? For example, 
categories can include union, non-union, part-time, full-time or senior management. In 
other words, do you give different Time-Off benefits, such as vacation time, to employees 
who worked for the same amount of time? 

For the above scenarios, you would set up separate Time-Off Plans. (SeeTime-Off Plans.) 

  
I entered a new employee, then ran an accrual and posted the time, but my 
new employee didn’t earn time. Why? 
  

Check the Time-Off Plan. If the Time-Off Plan is set up to run yearly on Jan. 1 and this employee 
was hired after that date, this employee will earn time only when the program accrues on January 
1 of the following year. We recommend using the Transactions Screen to enter the earned time 
manually for new employees in this situation. SeeTransactions Screen. 

  

Is there a limit to the number of Time-Off Plans? 
  
No. There isn’t a limit. 

  
Is there a limit to the number of Absence Categories? (Such as Vacation, 
Sick, Personal, PTO, Birthday, Comp Time?) 
  
No. There isn’t any limit. 



Time-Off Plans 
  

Gradience Attendance helps you manage your attendance with your Time-Off Plans. Based on 
your company Time-Off policy, you can define how often employees will earn time off, how they 
can carry over their balances from year to year and how much they will earn based on length of 
service. 
  



Setting Up a Time-Off Plan 
  
Note: It’s a good idea to have your company Time-Off policy (such as Vacation, Sick, & Personal 
time) with you when setting up your Time-Off Plans. 
Here’s an example of a Time-Off policy: 
Say your company’s vacation policy for full-time employees gives two weeks to those on staff for 
more than one year. (Employees under 12 months don’t receive any vacation time on this policy.) 
The company gives three weeks to employees with over five years on the job and four weeks to 
all other employees over 10 years. Vacation time is given all at once on each employee’s hire 
date each year. Excess time left over at the end of the year is not allowed to carry over. (The 
company does not pro-rate time.) 
Following along in the Time-Off Plan Maintenance screen, we’ll break it down this way: 

• Accrue Plan Name:Full-time Vacation 
• Method:Time of Service 
• (Select the Benefit Year and How Often to Accrue) When and How often do they 

receive time:On their Hire Date, Yearly-Once per Year. 
• (Select what to do with prior year balance) Carry over excess time?:Zero Balance 

from prior year. 
• (Pro-rate earnings from partial months & partial years) Pro-rate? No 
• Time earned in: Days 
• Earning Levels Start on Benefit Year: This enables an employee to begin earning the 

next higher amount at the beginning of the year that they reached his or her next level. 
• Max Annual Bank: This option allows you to cap "accumulated carry over" at an amount 

that you enter. 
• Earning Levels: 

  

 
 
Level 

 
From 
Month 

 
Up To 
Month 

 
Days Per 
Year 

Max 
Annual 
Earn 

Max 
Annual 
Carry 

Max 
Balance 
Allowed 

1 0 12 1 0 0 0 

2 12 60 10 0 0 0 

3 60 120 15 0 0 0 

4 120 9999 20 0 0 0 

  

Explaining the Earning Levels 
The From and Up Toblocks must be entered in Months. The keywords are UP TO.Level 1 
defined above shows From 0 months Up To12 months, not through or beyond 12 months. Level 
2 shows From 12 months Up To 60 months. Again it’s only Up To the 60th month,and not through 
or beyond. 
The Days Per Year block allows you to enter how much time an employee will receive per year. 
An employee with 3 years will earn 10 days given on their anniversary date. (An employee with 3 
years (or 36 months) will fall between row #2 above (12 – 60 months). When that employee 



reaches five years (or 60 months), they will automatically switch over to the next row (# 3) and 
earn 15 days per year. 
Once you have set up your Time-Off Plans, follow these steps to complete setting up: 

1. Assign the Time-Off Plans to your employees. (See Adding New Employees.) 
2. Enter (Initial) balances for all employees from a specific start date. (Transactions Screen.) 

For example, if you wanted to start accruing from January 1, 2008, from within the 
Category Assignments screen you would enter the starting balance for each employee as 
an initial balance earned. This would be what each employee would have as of December 
31, 2007 (one day BEFORE you want the program to take over). The program needs to 
have accurate starting balances for each employee. It is important that this be the "ending 
balance" for the previous year. 

3. When an accrual is run, the program will pick up where starting balances left off, and 
accrue according to how the Time-Off Plans are set up. 

This table is provided as an aid to help you convert days/weeks per year to the monthly amount in 
hours.  
 
Note: This table assumes an 8-hour workday,5-day workweek. 
  

Weeks Per Year Days Per Year Hours Per Year Hours Per Month 

 1 8 0.6667 

 2 16 1.3333 

 3 24 2.0000 

 4 32 2.6667 

1 5 40 3.3333 

 6 48 4.0000 

 7 56 4.6667 

 8 64 5.3333 

 9 72 6.0000 

2 10 80 6.6667 

 11 88 7.3333 

 12 98 8.0000 

 13 104 8.6667 

 14 112 9.3333 

3 15 120 10.0000 

 16 128 10.6667 

 17 136 11.3333 

 18 144 12.0000 

 19 152 12.6667 

4 20 160 13.3333 

 21 168 14.0000 

 22 176 14.6667 

 23 184 15.3333 

 24 192 16.0000 

5 25 200 16.6667 

 26 208 17.3333 

 27 216 18.0000 

 28 224 18.6667 

 29 232 19.3333 

6 30 240 20.0000 
  



Accrual Formula for Hourly Rates: 
(Number of hours per day multiplied by number of days total earned) divided by 12 months. This 
total is the amount that is earned per month rounded to 3 decimal places. 
  

Example:(8 x 5)= 40 hours / 12 = 3. 333 
  
Number of hours per day 8 multiplied by number of days earned5= 40. 

40 divided by 12 months = 3. 3333 (round to the fourth decimal place) 
 
 



Incorrect Balances – Where are they coming from? 
  

Balances may be incorrect for a number of reasons. The most likely reason is that the Time-Off 
Plans are not set up correctly. 
  
Here are some things to know and to check if your balances are incorrect and aren’t sure why: 

• A good report to check is the Transaction Detail report. This will show each transaction of 
absences and time given. This will usually help identify where to start looking. If an 
employee has 80 hours of Vacation time within his second month of accruing, the 
Transaction will show how much was given and when. 
 
 

• When an accrual is run, the program only accrues according to the Time-Off Plan. So, if 
the Time-Off Plan is set to accrue 40 hours on a monthly basis, the employees set up on 
that Time-Off Plan will receive 40 hours EACH month. Check the Time-Off Plan that the 
employees are on (especially the employees with incorrect balances). 
 
 

• Are all the employee balances incorrect or just one or two? If all of the employee balances 
are incorrect, make sure the Time-Off Plans are correct, remove the accruals and then run 
the accrual again. If just one or two are incorrect, the easiest thing to do is just make 
offsetting adjustments in the Transactions. 
 
 

• New Hires not receiving their time. Some companies allow their new hired employees to 
receive time (usually after 90 days) on Personal or Sick Time. But, their main policy for 
employees over 12 months receive their time on January 1stof each year. When a user 
sets up this type of policy, it’s usually set up to accrue only on January 1st, and not after 
the 90 days. This requires the new hires to be set up on an accrual table and then 
switched over to the main policy. Instead of creating two Time-Off Plans in this case, we 
recommend giving the new hires their time manually for the first year, while keeping them 
assigned to the main Time-Off Plan. After their first year, they will begin to accrue 
normally. 
 
 



Manually Entering Time 
  

There are a couple of items to set up, even if you will be entering all of your time manually. Most 
users that enter their time manually still want the program to zero out the balances at the end of 
the year, or even on the anniversary date. All employees need to be set up on three (3) Time-Off 
Plans even if you carry over the balances each year. 
 
 



Setting Up a Time-Off Plan to Zero Out Balances 
  

In order to accomplish this, you will need to set up a Time-Off plan to handle this. The following 
steps assume that you have already entered your employees, however, the Time-Off plan can be 
set up at any time. 

1. Click on Settings from the main menu, then click Time-Off Plan Maintenance. 
2. Click New. 
3. Enter an Time-Off Plan Name, such as Jan 1st, Zero Out. 
4. The following selections should be made: 

1. Method – Time of Service 
2. Select the Benefit Year – Select On the 1st(Calendar), if you want to zero out on 

January 1st, or Hire Date if you zero out on the anniversary date. 
5. Select How Often to Accrue – Select Yearly – Once per year. 
6. Select what to do with prior year balance – Select Zero Balance from prior year. 
7. Leave all other default settings and click Save. 
8. Click on the Category Assignments Feature. 
9. Click in the white box next to Vacation and select the name of the Time-Off Plan you set 

up in the above steps.Note: This step is only if you zero out your Vacation time. If you 
don’t zero out this time then select the None plan for Vacation. 

10. Follow Step 9 for the Sick and Personal categories. 
Note: Click Settings > Global Preferences > Attendance. Set Accruals to run. This way 
balances will "automatically" zero-out before the start of the year whether the year begins on 
January 1, the employee's anniversary or the start of the fiscal year, depending on your 
preferences. Otherwise, in order for the balances to zero out each year, you will need to run an 
accrual, on Jan 1stof each year, by going to File, Maintenance, and Perform Accrual, then clicking 
on Accrue Now. If you selected to zero out on the Hire Date you will need to run an accrual 
whenever you need to see the update balances. 



Explaining Accruals 
  

When an accrual is run in the Gradience Attendance program, it calculates employee absences 
from the last accrual date up to the current date or your computer’s date. The time calculates 
according to the settings in your Time-Off Plans. The accruals can run as often as once per day. 
For example, if you ran your last accrual on March 15, 2007, (your last accrual date), and if you 
ran your next accrual on March 30, 2007, the program would check the Time-Off Plans that each 
employee is assigned to and accrue time for employees who are supposed to receive time 
between those dates. So, if your employees were supposed to receive vacation days on the 
anniversary of their hire dates, they would receive these days. The program runs accruals 
manually or automatically. 
  
  



Reports 
  

Gradience Attendance was designed with more than a dozen reports and charts that relate to 
employee absenteeism tracking. For additional reports, please try Gradience Confidential 
Employee Record, which offers you the power of additional employee information tracking. 
  
  



List of Reports 

Here is a list of the Attendance reports you can run: 

 

• Attendance Detail 
• Employee Detail 
• Employee Summary 
• Employee Balance 
• Employee Anniversary 
• Perfect Attendance 
• Calendar 
• Absence Detail 
• Absence Notes 
• Bank Report 
• Scheduler Report 
• Worked Hours 
• Planner 
• Transaction Detail 
• Year in Review 
• Adjustments 
• Reminders 
• Charts 
• Table Listings 

The report feature will allow you to select individual employees and gives you various options. 
The list above shows basic options and each report may have other options as well. See the 
individual report for specific details. 
  
  



 Printing from the Reports feature 
1. From the Employee Select column, select which employees you want to report on; you 

may use either the Browse mode or TreeView mode to select employees. 
2. From the feature list, click Reports and then choose a report. 
3. Select sorting / filtering options in the Feature Pane, if needed, and click Preview. 
4. Click the printer icon to print. 

Each report has basic and additional options. Basic options are options that are available for all 
reports. Additional options are options that are available only for specific reports. 



Basic Report Options 

  
Each report has the same Menu, Grouping and Export options: 
  

Report Menu Options: 

• Preview– Displays the report with options to print and setup printer. 
• Print– Sends the report to the selected printer. 
• Printer Setup– Allows you to change the printer and printer settings. 
• Help– Displays help pertaining to this screen. 

Grouping Options: 

• Location– Groups data by Location. 
• Department– Groups data by Department. With Location also selected, the report will 

group by location, then department. 
• Show Group Totals– Shows total number of employees after Location and/or 

Departments with a grand total at the end of the report. Location and/or Department must 
be selected for this option to be enabled. With both Location and Department unselected, 
the report will group by Last Name in alphabetically order. 

Export Options: 

• Disable Headers on Export– When saving a report from the preview screen, you are 
given the option to save in different formats, such as .txt, .csv and .xls. With this option 
checked, this saves the file without headers so that the data can be manipulated more 
easily without the headers throwing the rows and columns out of place. 

Display Options: 

• Show Social Security Number on Report– This allows you the option of displaying the 
SSN on reports that include this data field. 

  
Alert For Former Optima Users: Options for selecting only Active, Inactive or Terminated 
employees no longer appear within the Report Options Pane. However, if you do need to sort by 
employment status, you can do so through the Sorting/Filter Page under the View menu. 
  
  



Employee Detail Report 

  
The Employee Detail Report shows pertinent employee information including Time-Off Plan 
assignments, balances, initial balances and notes from the Detail screen. Use this report when 
you need a quick overview of an employee’s balances. 



Employee Summary Report 

  
The Employee Summary Report shows an employee’s date of hire, title, status and work status. 
Use this report when you want an employee listing. 



Employee Balance Report 

  
The Employee Balance Report shows Time-Off Plan names and employee balances. Use this 
report to quickly view which Time-Off Plans your employees are on and their balances. 
  

Additional options for this report: 

• Select Totals– This allows you to view totals by Hire to Date or Year to Date. Hire to Date 
shows grand totals since the employee was entered into the program. Year to Date shows 
current year totals based on the Benefit Year setup under the accrual tables. A benefit 
year can be set to Hire Date, On the 1st(Calendar), or Fiscal Year. This affects how the 
totals are viewed on the Year to Date option. For example, if the benefit year for the 
accrual table an employee is assigned to is set to Calendar (On the 1st),the current year 
totals would show from January 1stto December 31st(Calendar year). If the setting was on 
Hire Date, then the current year totals would show from anniversary date to anniversary 
date for the current benefit year. 

• Thru Date– This allows you to select an ending date to view totals. 



Employee Anniversary Report 

  
The Employee Anniversary Report shows an employee’s title, years of service, hire date and 
anniversary date. 
  

Additional options for this report: 

• From & To Date– This allows you to select a beginning and ending date to view employee 
anniversaries. For example: to view all anniversaries in 2008, you would enter From 
01/01/08 To 12/31/08 and click on Preview. This will show you how many years of service 
and the date of an employee’s anniversary, along with his or her name and title. 



Perfect Attendance Report 
The Perfect Attendance Report shows employees who do not have absences that count against 
perfect attendance. Use this report to quickly spot employees who have good attendance. 
  

Additional options for this report: 

• Attendance Date– allows you to select a beginning and ending date to view employees 
who don’t have absences that count against perfect attendance (see Count Against 
Perfect Attendance under Absence Code Maintenance). 



Attendance Report 

The Attendance Report allows you to view a full year of dates with Absence Codes for a single 
employee on a single page. 



Absence Detail Report 

  
The Absence Detail Report shows employee absences. Use this report to quickly spot absence 
abuses or trends. 
Additional options for this report: 

• Attendance Date– allows you to select absence dates you want to view. 
• Report Only Selected Absence Code(s)– When selected, this allows you to select 

multiple absences by holding down the Ctrl key and clicking on an absence. Holding down 
the Shift key and using the arrow keys on your keyboard allow you to select multiple 
absences consecutively. If unselected, it will report on all absences. 

 
Note:When selecting multiple absence codes, make sure you have one of these symbols next to 
it: or .These designate selected absences to print. The second symbol (arrow with a dot) 
designates which row your cursor is on. A filled-in arrow designates only which row your cursor is 
on, not that the absence is selected. 



Absence Notes Report 

  
The Absence Notes Report shows notes for absences according to the Attendance Date range. 
Use this report when you want to view only absences for a particular date range. 
Additional options for this report: 

• Attendance Date – allows you to select dates to view with absence notes. 
Note: If you want to view absencesandnotes together, see the Absence Detail report. 



Scheduler 

  
Gives you a calendar format to view absences. This report is similar to the Absence Detail report 
except that this report does not show absence notes. 
  

Additional options for this report: 

• Attendance Date – allows you to select absences by a date range. Quick Dates allow you 
to select a date range at the click on a button. 

• Only Show Months With Activity – allows you to view only months with absences. 
• Report Only Selected Absence Code(s) – when selected, allows you to select multiple 

absences by holding down the Ctrl key and clicking on an absence. Holding down the Shift 
key and using the arrow keys on your keyboard allow you to select multiple absences 
consecutively. If unselected, it will report on all absences. 

 
  

When selecting multiple absence codes, make sure you have one of these symbols next to it:  or 
. These designate selected absences to print. The second symbol (arrow with a dot) designates 

which row your cursor is on. A filled-in arrow  designates only which row your cursor is on, not 
that the absence is selected. 



Worked Hours Report 
  
The Worked Hours Report shows hours worked by a selected date range. The “W” Worked Time 
code must be placed on the calendar for each day worked for each employee being tracked. Be 
careful when unselecting the Use Date Range box as this will show all dates of time worked and 
may take a while to show the report. 
  

Additional options for this report: 

• Use Date Range– This allows you to select a date range. 
• Print Detail– This allows you to view only summary of totals. 
• Sorting– This allows you to sort by Date or Employee. 
• Group Hours Worked By– This allows you to group by Week, Month, Year or None of 

these. As you select one of these options, the Date Range changes to reflect the selection. 
• Week Starts On– This allows you to select a starting day. As you select one of these 

options, the Date Range changes to reflect the selection. Note: Week must be selected 
under Group Hours Worked By for this option to be activated. 



Planner Report 
  

The Planner Report allows you to view absences by hours in a calendar format. This report is 
similar to the Year in Review, except the Planner Report is mainly by absences. 
Additional options for this report: 

• From Date and Through Date– This allows you to select specific dates. 
• Date Range Used for Year to Date Totals– Report Date Range allows you to view totals 

from a specific date range. This date range defaults to January to December of the current 
year. Date Range Assigned by Time-Off Plans allows you to view totals that reflect the 
Calendar screen. 

• Only Show Months With Activity– This allows you to view only months with absences. 
• Absence Categories– This allows you to choose which categories you want to view. 



Transaction Detail Report 

  
The Transaction Detail Report allows you to view all transactions since the employee was 
entered into the program or within a selected date range. Use this report to view transactions in a 
checkbook-style format. 
Additional options for this report: 

• Report Settings– allows you to select a date range for transactions, and whether to show 
“Holiday and Other”. (See Not Assigned under Absence Code Maintenance.) 



Year In Review Report 
  

The Year In Review Report allows you to view selected absence categories in a calendar format. 
This report is similar to the Planner Report, except the Year In Review absence categories are 
mainly by dates. 
  

Additional options for this report: 

• From Date and Through Date– This allows you to select 
specific dates. 

• Date Range Used for Year to Date Totals: Report Date Range– allows you to view 
totals from a specific date range. This date range defaults to January through December of 
the current year. Date Range Assigned by Time-Off Plans allows you to view totals that 
reflect the Calendar screen. 

• Only Show Months With Activity– This allows you to view only months with absences. 
• Absence Categories– This allows you to choose which categories you want to view. 



Adjustments Report 

  
The Adjustments Report shows manual adjustments and notes. A manual adjustment is entered 
through the Transaction Editor as an Adjustment. 
  

Additional options for this report: 

• From Date and Through Date– allows you to select a date range for to view adjustments. 



Reminders Report 
  

The Reminders Report shows reminders sorted by Date, Name, Topic or User Name. 
Additional options for this report: 

• Sort Options– This allows you to sort by Date, Name, Topic or User Name. 
• Filters– This allows you to filter by User Name, All Users, Resolved, Unresolved and 

Global Only reminders. 



Charts 

  
Charts can help you identify absence trends in your company. Using the charts, you can track 
employee absences. Gradience Attendance has four charts to choose from: 

• Absences Over Time– Enables you to view and compare employee absences over a one 
year period. 

• Absences by Type– Enables you to view and compare employee absences by type of 
absence. 

• Location Comparisons– Enables you to view and compare employee absences by 
location. 

• Department Comparisons– Enables you to view and compare employee absences by 
department. 

Chart Options: 
  

When you click on Run Graph you will have the following options: 

• Preview&Print– This shows a preview of the chart. 
• Printer Setup– This allows you to change your printer settings. 
• Close– Exits the Chart screen. 
• Help– Brings up Help pertaining to this screen. 
• Chart Type– Gives you the choice of viewing as a Pie, Bar Graph, Line, or Point Chart. 
• Color Assignments– This allows you to set the colors of a specific data set. 
• Display– Toggles the Legend (data box next to the chart), Parameters (data at the bottom 

of the chart), and Ignore Zeros (any data on the chart with zeros). 
• Label Display–Toggles the Label only (months), Value only (see Value Display), or Label and 

Value. 
• Value Display–Toggles the value as a number (count), percentage, or Percentage Of 

(shows as: [percentage] of [total count]). 
• 3D Control– This allows you to view the depth of 3D by moving the arrows. 
• Rotation– Rotates the chart in the desired direction. 
• Explode Biggest– Moves the largest piece away from the pie. 



Table Listings 
  

Table Listings enable you to view and print out the following settings: 

• User Security– This prints user name with security settings. 
• Global Preferences– This prints global preferences settings. 
• Locations– This prints all locations. 
• Departments– This prints all departments. 
• Assigned Departments– This prints Locations with assigned departments. 
• Time-Off Plans– This prints all Time-Off Plans. 
• Absence Categories– This prints all absence categories. 
• Absence Codes– This prints all absence codes. 
• Company Holidays– This prints all holidays entered into the program. 

Steps to print a Table Listings report: 
1. From the Reports menu, select Table Listings. 

You will then see the screen below. 

 
2. Choose the Table Listings report you would like to run. 
3. Click Preview to view the report or Print to print out the report. 

4. In Preview mode click the  print icon to send the report to your printer. 



Custom Reports 

From any report feature (and after selecting filters and options such as Date ranges, Location and 
Department groupings, etc.), you can begin the process of creating a custom report. Custom 
Reports are a function of the FastReport™ engine built into Gradience. The purpose of this 
tutorial is to take you through the process for creating a custom report, editing some basic 
information inside FastReport, then showing you the outcome. For a full tutorial on working with 
FastReport, please see the FastReport documentation. 

Custom Reports give the user the option to present data from the original (template) report in new 
and exciting ways. How it works: The “default” Gradience report (called a “template” inside the 
application) is used as a base for the new custom report. The user always can start a new report 
from scratch, but it is usually easier to create a new report by modifying a copy of the original 
template. 

To create a custom report based on an existing report, you would click the Save As button and 
select a new name for the report. You then would proceed to edit the new “copy” of the report. To 
edit an existing report, select the report and click the Edit button. If you attempt to edit the 
“Default” report, a new name will be assigned automatically. 

To create a custom report, follow these steps: 

1. For this example, we will use the original Attendance Detail report as a template to create 
a new (custom) version of the report. Start by navigating to Reports > Attendance Detail.  

2.  Locate and click the Custom Report icon near the top right of the page.  
3. A new window titled Custom Reports – Attendance Detail will appear (shown below). As 

you can see, the current report name (in grayed-out text) is Attendance Detail Template.  

 



4. A Custom Sort can be selected by using the drop-down selection in the Custom Sort Fields 
section. Custom Sort Fields work by allowing you to select a field that will be used to sort 
the records on your custom report. Some built-in examples include LastName and 
EmployeeID, and ReportDefault appears as the default selection when you create your 
first custom report (you probably will want to change the default selection). Click Edit first, 
then click the (+) button to the right of the drop-down to edit a Custom Sort field or create a 
new one. 

5. A Custom Filter can be selected by using the drop-down selection in the custom filter 
section. Because you already have activated editing for items in this window, you can go 
ahead and click the (+) button to the right of the drop-down to edit Custom Filters or create 
new ones. 

6. By clicking the View Data button, you can see the results of any changes made to the sorts 
or filters. This can be very helpful when creating your own custom reports because you will 
be able to “preview” your report before you actually begin editing it in FastReport. 

 

7. After previewing your data, click Close in the viewer window to return to the Custom 
Reports window. 

8. If the report you wish to customize is not highlighted in the ReportName section, select the 
desired report now. 

9. Clicking New or Edit will bring you into the FastReport custom report designer. While in the 
designer, you will have the option to save the report as another name or save it to an 
external FastReport 3 (.fr3) file. You also will have the option to open a previously created 
FastReport file and save it in your database. See Help/Help Contents while in the designer 
for more information. 



 

10. Once you are finished editing your custom report in the designer, click File > Save, Save 
As or Exit to close the report to return to Gradience. 

Note: Tech Support does not offer training on Custom Reports. However, we can e-mail you a 
tutorial on Custom Reports free-of charge. To request a copy go to www.gradiencesupport.com 
and click on Ask a Question.  



Before Contacting Technical Support  

Please follow these guidelines before contacting Technical Support:  

• Remember, Gradience does not support setting up networks or computer configurations.  
• If you are having problems with your computer, try rebooting to see whether that corrects 

the issue. 
• If you are getting an error message, an access violation or encounter the software 

behaving in a manner that is unusual, go to the computer where the database is located 
and run the Database Maintenance. 
 
From the desktop click on Start > Programs (or All Programs) > Gradience > 
Maintenance > DB Maintenance. When the DB Maintenance window opens click on the 
Start button within that window. When it is finished, see if the issue that you are having 
with the software persists. Often this utility will resolve the issue. 

• If the issue is an error message and the Database Maintenance did not resolve it, please 
write down the whole message or take a screen print of it by clicking on the Print Screen 
key in the upper-right of your keyboard and then, paste it into MS Word or Wordpad or 
Notepad and save it to send in an e-mail to Tech Support later.  

• When communicating with Tech Support be ready to first indicate the “full” name of the 
software and the “full”, multi-digit version number of the program. You can find this by 
opening the program and clicking on Help and then clicking on About. A pop-up window 
will open that will indicate the “full”, multi-digit version number of the program. Sometimes 
the answer depends on this version number.  

• Indicate the steps that you took that lead-up to the problem that you have encountered.  
• Indicate whether you were able to run the Database Maintenance or not and whether it 

had any impact.  

  



Contacting Technical Support       

• Version 10 was introduced in November of 2007. We support the “current” version (10) 
and the “previous” version (9). A “Pro” license allows you to install it at one site and get 
support for that site. An “Enterprise” license allows you to install it at multiple sites and get 
support for each of those sites.  

• FREE phone support during the 30-day DEMO  
• FREE phone support for the first 30 days after you purchase the software  
• Technical support for by e-mail is ALWAYS FREE. Just go to www.gradiencesupport.com 

and click on:  
o Get Fast Answers to do a keyword search.  
o Ask a Question to request help from a Technical Support representative.  

Long-Term Phone Support 888-925-7740 (8:30 AM to 6:00 PM Eastern Time Monday 
through Friday except Holidays) 

• With a Maintenance Plan: One full year of phone support (not training) for technical 
issues and FREE software upgrades. For details call 800-999-9111 or 888-925-7740.  

• Without a Maintenance Plan: You will be charged $29.99 for each call to Tech Support.  
Assistance with understanding how to use the software 

• Professional Services: Get up to two hours of training and help setting up the software. 
For details call 800-999-9111 or 888-925-7740.  



Getting Help 

There are several ways to get help throughout the program.  
   



Sample Database  

A sample company (called a tutorial database) is provided so you can view the different screens 
with sample data already filled in. It is recommended that you use the program with the tutorial 
database to get a feel for the program without having to worry about altering live data. When you 
are in the tutorial database, no changes are made to your live database. To open the tutorial 
database, select Start, Programs, Gradience, Data. 

The Help Menu 

From the Help menu, select Contents. A listing of help topics is displayed. Select the Book that 
interests you (using a double-click), and then double-click the topic you wish to display.  
   



The F1 Key 

Pressing the F1 key is another way to obtain help within the program. From most areas of the 
program, pressing  F1 will display the topic associated for that screen.  
   



Searching for Help 

You can search for Help two ways using the Help File.  
Method 1 – From the  Help menu, select  Search for Help on. The Help Topics Index will 
appear. Select the Topic that interests you.  
   
Method 2 – From the Help menu, select  Contents. Click the  Find Tab. If you have not used this 
feature before, the Find Setup Wizard will walk you through setting up the search index. Once the 
search index has been created, type in the Keywords you would like to search for, and the 
results will be displayed.  
   

A list of typical errors or messages that were known at the time of publication is in Appendix B – 
Troubleshooting.  
   

For more complete information, please refer to one of the following: 

• Read me. txt file in the C:\Program Files\ Gradience\Common program directory.  
• Help File in C:\Program Files\Gradience\Common or accessible from the Start Menu.  
• Internet Site www.gradiencesupport.com 

   
   



Importing       

You may import only the fields on the Field Layout There are two different file formats that you 
may import from:  

• Tab Delimited (recommended)  
• Fixed Length 

  
For a Tab Delimited format, you may use any program that allows you to save as Tab Delimited. 
Excel and Access are two that will allow this. Tab Delimited is the recommended format.  
  
Note: You cannot import directly from an Excel file (.xls extension). Once you have finished 
formatting your data in the Excel file, you will need to save as type: Text (Tab Delimited). When 
entering your information into a spreadsheet such as Excel, you will need to follow the order of 
the field names according to the Field Layout page.  
  

For example, the columns should have SSN first, then Last Name, First Name, etc. Also, you will 
need to leave a blank column for any fields that you will leave blank. For example, following the 
format on the Field Layout page, we create a Tab Delimited file with the fields: SSN, Last Name, 
First Name, [blank column for Middle Initial field], Location, Department, Date of Hire, Full/Part 
Time, [blank column for Title field], [blank column for Employee Code field] and Active Status. 
All of the fields in bold are required, which means that these columns may not be blank. We 
would still need to have a blank column for MI, Title and Employee Code in the order of the fields.  
  
For a Fixed Length format, you may use the DOS Editor or any other editor that shows you the 
field length. The lengths of each field must correspond to the Length column under the Field 
Layout page. We recommend using the Tab Delimited format.  
  

Preparing the software for Import 
You must create/setup your Locations and Departments in the gradience program before 
importing. In other words, you must go to Settings > Locations/Departments from within the 
gradience program and enter your locations and department names before importing your data. 
Please refer to the manual for instructions on creating your Locations and Departments. 
  

Import Field Layout 
  

The following is the field layout for importing text files into gradience. Fields shown in bold type 
are required and all import text files must include them. The alphabetical arrangement as 
indicated by the letters on the left indicates the columns under which the information would fall 
within an Excel spreadsheet.  
  

You MUST have a column for each type of information (both “required” & “Not-required” data) 
shown below. Only the items in BOLD below are required. The items not in BOLD below are not 
required fields but the columns which would contain the non-required information MUST exist 
even if they are blank. The data may not be required but the column that would contain such data 
is.  
  

For example:  
If no Social Security Number is available, column A is still required but may remain blank. The 
Last Name is required and MUST appear in column B.  
  

Field Layout Requirements: 
Social Security Number 11 123-45-6789 
Last Name 20 up to 20 characters 



First Name 
20 up to 20 characters 

Middle Name 20 up to 20 characters 
Location 50 up to 50 characters 
Department 50 up to 50 characters 
Date of Hire 10 MM/DD/YYYY (slashes required) 
Full/Part Time 9 Full-Time or Part-Time (only) 
Title 30 up to 30 characters or numbers 
Employee Code 14 up to 14 characters or numbers 
Active Status 10 Active, Inactive, Terminated 

If you have Confidential Employee Record installed, your text file can also include the 
following fields:  

  

Date of Birth 10 MM/DD/YYYY (slashes required) 
Address 1 30 up to 30 characters or numbers 

Address 2 
30 up to 30 characters or numbers 

Home Phone 30 800-123-4657 (dashes required) 
City 30 up to 30 characters or numbers 
State (2 character) 2 2 characters, i.e., FL 
ZIP Code 15 33325-1234 (-1234 can be omitted) 
Salutation 5 Mr., Mrs., Ms. or Dr. (only) 
Employee Security Level 16 up to 16 characters or numbers 
Security Clearance Date 10 MM/DD/YYYY (slashes required) 
Race 25 Must match a valid race on detail tab. 

EEO Category 25 Must match a valid category on the detail tab. 

Sex M/F 1 M or F only 

Driver's License Number 15 up to 15 characters or numbers 

I-9 Renewal Date 10 MM/DD/YYYY (slashes required) 

Veteran Status 25 Disabled, Vietnam Era, Other Veteran 

Office Phone & Ext. 30 800-123-4567 Ext. 123 

Fax 30 800-123-4567 

Email Address 30 up to 30 characters or numbers 

Address Effective Date 10 MM/DD/YYYY (slashes required) 

  



Exporting       

The export feature is used to transfer basic employee information into a text file that you can 
open in any word processor or spreadsheet application. Only the basic information (see Field 
Layout) will be exported.  
To export your information, follow these steps: 

1. Click File > Export. 
2. Select Tab Limited or Fixed Length for the Export File Type. 
3. Enter a path and file name or keep the default name. 
4. Click Export.  

Your export file will be created as the file designated in the file block. You may rename the file, 
but we recommend keeping the file extension of .txt. After exporting, you may open the file from 
within any other spreadsheet or word processor program.  
   
NOTE: Only the information in the Field Layout will be available for export.  
   

   



Importing and Exporting Data 

The import function allows you to add new data from a text file into the Gradience program. 
Conversely, the export function allows you to export data from the Gradience program. 
   

The software you export your data from must be able to export the required information to a Tab 
delimited or fixed-length text file. See the required import fields. Please note that we cannot 
provide support for other software program(s). Please contact the software vendor or 
manufacturer for more information on how to export data from your other software. 
   

   



Import Features       

Feature Description 
Load 
File 

Loads the selected file into the data window. 

Test  This tab will not highlight until a file is loaded. This checks for blank records and ensures that the 
department and location names that are being imported are already in the database.  

Import This tab imports the file into the database.  
Help This brings up the Help file pertaining to Importing. 
Close This closes the Import screen and takes you back to the main screen. 

 
Feature Description 
Import File  This allows you to enter the path or navigate to the file you will be importing.  
File Type  This allows you to select the file type.  

a.   Tab Delimited – We recommend exporting or importing as this type of file.  

b.   Fixed Length – Gradience may export or import fields with a fixed length.  
Skip First 
Line  

This will take out the first row, in case you have headers. 

Check 
Duplicates  

This allows you to check for duplicates against the import file and the files already in the database. 

   



Backing Up  

How often should you back up? 
Every company is different regarding its backup needs. One thing to remember is, “It’s not if your 
computer is going to crash, but when.” They have made great strides in making computers more 
reliable, but that just makes the time longer before something can happen to your computer.  
   

The following pertains to any data on your computer and not just your Gradience program. Ask 
yourself this question, “If my computer were to crash right now, how long would it take to re-
create (reenter) all of my data without a backup?” Then ask yourself, “If I had to restore from a 
backup, would I be OK with last week’s backup, when I have to re-enter a week’s worth of data? 
Would I be OK with restoring a backup from three days ago? 
   

When restoring your data, the information will be only as current as your last backup. So, if you 
did a backup two weeks ago and had to restore this backup, you would need to reenter the data 
that didn’t get backed up.  
   

Back up after you make changes to your employee records.  
It is recommended that you back up your database after making any significant changes to 
records. For example, any time you enter several employees or input many changes to absence 
information would be a good time to back up. You also may set up the DB Monitor to 
automatically back up at assigned times.  
   

Rotate backups and store backup copies offsite.  
A good backup routine is to have at least three sets of backups covering different days of the 
week. This practice is called rotation and reduces your risk of data loss. It is also a good practice 
to always keep one copy offsite in case of a fire or flood. Consult your system administrator for 
your company policy regarding data storage.  
   
A Restore is when you recover from a backup. There are three different uses for the restore 
feature.  A Restore may be done only through the DB Monitor.  

1. To overwrite the current data with archived data. 
2. To recover from a hardware crash. 
3. To move information onto a new computer. 

   

Please keep in mind, when you restore data, your information will be only as current as the 
backup you are restoring from.  
   

IMPORTANT NOTE 
The backup file may be saved only to the Server or Standalone Computer where the database 
resides. The backup creates a zipped file with an extension of .gbk.  
   



Creating a Manual Backup from Within Gradience 

To perform a manual backup from within the Gradience program, follow these steps: 
1. From within Gradience, go to File > Maintenance > Backup > Backup Database. 
2. If you are running the backup utility from the Server or at a local PC in which the database 

resides (Standalone), you will have the option to select where you want to back up to. If 
you are running the back up utility from a Client (Gradience client install), it will 
automatically run the backup, saving the data where the database resides.  



Creating a Manual Backup from Within DB Monitor 

To perform a manual backup from within DB Monitor, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, Gradience Maintenanceand 

clicking on DB Monitor.  
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your administrator.  
3. Click the Backup Tab.  
4. Click Yes to the message,  “Do you want to perform a sweep after the backup 

completes?”  Note: A Sweep is a maintenance feature that keeps the database working 
at peak performance.  

5. Click OK at the Select Directory screen. It is highly recommended that you keep the 
default location.  Note: You may back up only to the Server or standalone computer where 
the database resides.  

6. Click Close when the backup is complete.  
   



Scheduling Automatic Backups 

To create a scheduled backup, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, Gradience Maintenance, 

and clicking on DB Monitor.  
2. Enter your login and password. If you do not have access to the DB Monitor Backup 

feature, you will need to see your administrator.  
3. Click the Backup Tab.  
4. Click New Backup.  
5. Enter the Backup Type by selecting Daily, Weekly or Monthly.  
6. Enter the military time when you would like the backup to take place.  
7. It is recommended to keep the other default settings of Performing Sweep and the path of 

the backup. A different backup will be created for each scheduled backup. Note: The 
name of the backup will be: [Type]_Backup_[mm-dd-yyyy]_[time] to distinguish it from 
other backups. For example, Weekly_Backup_08-02-2008_2300, or 
Monthly_Backup_09_01_2008_1700.  

8. Click Save. The backup will be performed within a minute of the scheduled time.  Note: 
The Server or standalone computer containing the database must be turned on for the 
backup to complete. If the computer is not on at the scheduled time, the DB monitor will try 
to create the backup the next time it is opened.  



Restoring from a Backup 

Remember, restoring a backup will overwrite all data in the current database. Restore may be 
run only from the DB Monitor on the Server or standalone computer. To restore, follow these 
steps: 

1. Go to the Server where the database files are stored. (Restore cannot be done from a 
Workstation.) 

2. Open the DB Monitor program by going to Start, Programs, Gradience Maintenance, 
and clicking on DB Monitor.  

3. Enter your login and password. If you do not have access to the DB Monitor Restore 
feature, you will need to see your administrator.  

4. Click the Restore Tab.  
5. Click the database to restore.  
6. Click Browse and double-click the backup you wish to restore.  
7. Click Start Restore.  
8. After Restore is complete, click Hide to minimize the DB Monitor.  

You may open the program to see your restored data.       
   



DB Monitor  

Go to Start > Programs > Gradience > DB Monitor. 
   

The DB Monitor allows you to change the Server Name and Database Path, Backup and Restore 
your database, view database information and clear inactive connections. It also will show you 
what Gradience version each client computer is running. This is good to make sure everyone is 
on the same program versions.  
Feature Description 

Settings This allows you to change the Server Name and Database Path.  
Backup This allows you to set up a backup schedule or back up now. See above for creating a backup. 
Backup History This shows all backups completed. You will need to manually delete old backups from within 

Windows Explorer. 
Restore This can be done only from the same drive in which the database resides. For example, if the 

database was on a Server, the restore could be done only FROM the Server, not from the Client 
Workstation. See above for steps on restoring. 

Information This allows you to view how many users are connected to the database and where the current 
database. The Server Version information is the version of Interbase (database).  

Statistics This gives information on the database. Normally you will not need this information.  

 
Connections This allows you to view who is connected and any inactive connections that need to be cleared.  

   

Clearing Connections 
Go to Start > Program Files > Gradience and select DB Monitor.  
   

To clear a connection, follow these steps: 
1. Make sure all users are out of all Gradience programs. 
2. From the Connections Tab of the  DB Monitor, click on the  Refresh button and make 

sure all Computer Names have an “N” under Active Connections. 
3. Click Clear Inactive Connections. This will clear all connections listed with an “N” under 

Active Connections. 



Performing Maintenance and Repairing the Database       

The DB Maint is different from the DB Monitor. The DB Monitor utility allows you to view current 
connections, back up and restore, and view backup history. The DB Maint utility allows you to 
perform maintenance and attempt to repair a corrupted database.   



DB Maintenance Utility        

Details:  
  

Note: This can only be run at the computer where the database is located.  
  

When should it be run?  

• Run it any time that the program performs oddly. If you perform a routine task but get 
unusual results you may have database corruption.  

• We recommend that you also run the database maintenance once per month regardless of 
program performance.  

  

Why should it be run? 
Run this utility to remove database corruption. A database can become corrupt a number of 
ways.  
  

One way the database can become corrupt is through an electrical interruption. We recommend 
that any workstation running the software be connected to a UPS (Uninterrupted Power Supply) 
An inexpensive UPS will give you enough time to close programs and shut down the computer 
properly after a power failure.  
  

Another cause of database corruption is when someone who is running a Gradience program or 
Gradience TimeStation that has been minimized, turns off the computer without first closing the 
program or the TimeStation.  
  

How is it run? 
1. Click on their Windows Start button.  
2. Click Programs.  
3. Click gradience. 
4. Click Maintenance and select DB Maintenance.  
5. Click the Start button that appears on the DB maintenance screen. This should remove 

the corruption from the database.  
6. Close the DB maintenance utility when it is finished and try to open gradience again.  

  
If you have run this utility to resolve a performance issue but the issue persists you have 
two options: 
  

Option One:  
Restore from a recent backup that was made prior to the issue that is now occurring. You will lose 
any data that had been entered since the time that the backup was made.  
Option Two:  
Do a backup and attach the backup to an e-mail and send it to Technical Support. Technical 
Support will “attempt” to remove the suspected database corruption that may be the cause of 
your underlying issue. Technical Support will return a clean backup to you that you can then 
restore into your database.  
  
Note: Although Tech Support clears out corruption in nearly every case, there is no guarantee 
that they will be successful. Be sure to let Tech Support know what the name and the “full” multi-
digit version number of your program.  

  
To find the “full” version number from within he program click on Help (next to Reports) and 
then, click on About 



Database Repair 

If you can’t open the Gradience program, we recommend running the DB Maint utility. It will 
attempt to repair a corrupted database. If the utility does not repair the database, please save 
screen shots of the error messages and contact Tech Support.  
  

We recommend that you make a backup of your database and send a copy of the backup to Tech 
Support via e-mail. Tech Support may be able to repair it. 
If tech Support is able to repair it, they will e-mail it back to you. You can then, restore it into your 
database. 
If Tech Support is NOT able to repair it, you will be advised to restore the most recent backup that 
was made before the problem occurred.  
  
   



DB Maint Features 

The DB Maint utility has the following features: 
Features Description 
Start Begins the maintenance or repair. 
Cancel Stops the maintenance or repair process.  
Print Prints the error message(s). The Print button will not appear unless there are errors. 
Copy Copies the error message(s) to the clipboard. This will allow you to paste it into an e-mail. The Copy 

button will not appear unless there are errors.  
Close Exits the DB Maint utility. 
   
Note: The DB Maint utility will attempt to repair the database that the hrware.ini file points to. (Go 
to Start > Run, and enter: hrware.ini. Locate [HRWARE] in brackets and see the Server name 
and Path for the directory of the Gradience database.) 



Troubleshooting 

Here are the most common problems you may experience when using Gradience.   

• Unable to connect to Interbase Server 
• Getting SQL Parse Error: EOF in String Detected message when logging in 
• Unable to install on a Win NT or 2000 system 
• Exceeded the authorized user count 
• Moving database from one location to another 
• Installing Gradience files to another drive other than c:\ 
• Installing Update from one location 



Unable to Connect to Interbase Server             

Users Affected 

Gradience Attendance 
Gradience Records 
Gradience TimeClock 
   

Issue 

When launching one of the programs above, the following message may be encountered: 
   

"This program was unable to connect to your Firebird/Interbase Server. This likely is due to the 
fact that the default Interbase User Account has been changed. Please provide a User Name and 
Password with Administrative Privileges to Interbase." 
   

Description 

Users may encounter this issue for one of the following reasons. 
If running from a Server: 

1. If you're using an NT server and trying to install the database files to a drive other than C:\, 
permissions to the database folder may be incorrect. 

2. If running from a Standalone Computer: 
3. Interbase Guardian may be shut down 
4. If running from a Client Workstation: 
5. Incorrect Server Name and/or Database Path 
6. Client needs to have TCP/IP installed 
7. Server may be down 
8. Attempting to launch remotely. Remoting tool cannot resolve "Localhost" or "Name of 

Server." Change these to the Server's IP address in the hrware.ini file. 
Possible Resolution 

1. If running Gradience from a Server and encountering the above problem, try each of these 
solutions: 

2. Check your permissions for the Database folder. Full Control access must be given to 
System for the database folder. You may add to the Permissions by going through 
Windows NT Explorer and going to Properties by right-clicking the database folder. 

3. Check to make sure Interbase Guardian (or Interbase Manager) is running. 
4. On a Win 95/98 system, there will be an icon in the system tray (next to the clock). The 

icon graphic appears as a gray tower with a green flag. When you put your mouse over the 
icon, it will read, "Interbase Guardian". This icon will not appear on a Win NT/2000 system. 
You may check to see whether it is running on a Win 95/98/NT/2000 system by clicking on 
Start, Settings, Control Panel and clicking on the Interbase Manager. If it is not running, 
click on Start (from within the Interbase Manager), then try to open the Gradience 
application again. 

5. If encountering the message when running from a Client Workstation, try this: 
6. Check the Server Name and Database Path by going to the Server, opening the 

Gradience application and clicking on Help, System Information and printing out this 
information from the TechSupport Tab. (If you don't have the TechSupport Tab, then you 
have an earlier version of Gradience and will need to do a screen shot of the System 
Information screen and Current Users screen and print them out.)  

7. Once you have the Server information, go to the Client Workstation you cannot connect to 
the Server with. From the Workstation, click on Start, Run, and enter: HRWARE.INI. Verify 
that the Server Name and Database path are the same. 
   



NOTE: The printout of the Server Name and Database path you were asked to print or 
write down when installing the Server side must be exactly the same when entering this 
information on the Client Workstation(s)!  
   

8. The Client needs to have TCP/IP installed. 
9. This is done through the Network Neighborhood Properties. Please see your Network 

Administrator if you need more assistance in setting this up. 
   

If everything is the same on the Client as it is on the Server and you're still unable to 
connect, then try this: 
   

If your Server has a static IP Address, try entering this for the Server name when installing 
to the Client Workstation. 
   

10. If running from a Client Workstation and you went through the steps above and it didn't fix 
the problem, check with your MIS or Network Administrator regarding the status of the 
Server. 

   



Getting SQL Parse Error: EOF in String Detected                   

Issue: Getting an error message when logging in. Receive the following error message when 
logging in: SQL Parse Error: EOF in String Detected 
   

Description: This is caused when pressing the comma key ( , ) and Enter key at the same time. 
   

Possible Resolution(s):  

Avoid pressing the comma and Enter key at the same time.  



Unable to install on a Windows 2000 system             

Issue: Doesn’t finish installation. 
   

Description: This usually happens if you do not have full administrator rights on the Windows 
2000 computer. 
   

Possible Resolution(s): 

Make sure you have full administrator rights before installing.  



Exceeded the Authorized User Count             

Issue: 
You have exceeded the authorized user count. Your product license allows up to [number of 
licensed users] simultaneous users. There are # connections at this time. 
   

The # connections is a number greater than one that changes each time you close and reenter 
the program. 
   

Description: 

Users may experience this problem when closing the program by clicking Exit under the File 
menu. Users who exit the program by clicking the close window icon in the top right corner will 
not experience the problem, but we still recommend downloading and installing the latest update.  
   

Possible Resolution: 
Download and install the latest Gradience program from our Updates area on our Web site at: 
www.gradiencesupport.com. 
   

Please follow the installation instructions. After downloading and installing the update, follow the 
steps below to clear the connections. 

1. Close Gradience and any other Gradience Programs that are open. 
2. Open DB Monitor and log in, if it is not already running. The DB Monitor resides on the 

computer where the Gradience database is installed. 
3. Click the Connections button. 
4. Click the Refresh button to verify all connections are "N" (not active).  
5. If all connections are "N", then Click the Clear Inactive Connectionsbutton. This will reset 

the connections.  
6. If you wish to close the DB Monitor (not recommended if you have automatic database 

backups scheduled), right-click on the icon Gradience Database Monitor in the system 
tray area; select Shutdown Database Monitor, and click OK to close DB Monitor. 

7. Otherwise, click the Hide button. 



Moving Database from One Location to Another 

Steps to follow:  
1. Install the software on the new server. (See Installing Gradience).  

 
Note: In the event that you have had your CD for a number of months you may not be 
running the latest “edition” of the version you own. We recommend that you download the 
latest ‘edition” of your version from our Tech Support web site. 
 
Go to www.gradiencesupport.com and click on Download latest versions.  
 

2. Download the appropriate program, saving it to the desktop of the server.  
3. Install it on the server doing a Server installation and then pick Custom or Express. This 

will create a new “blank” database on the new server. Take note of the location of the 
database, return to your client workstation(s)  

4. From the desktop of each client workstation click Start > Run. Enter hrware.ini into the 
field and click OK. A NotePad window will open.  

5. At the top you will see the following …  
[HRWARE]  
SERVER= (the name of the computer where the database had been)  
PATH= the path to the database)  
The second and third lines may be reversed on your ini file.  

6. Edit the SERVER name and if necessary, edit the PATH line, Save and close. This will 
“point the program on this computer to the new database location. There is no data there 
yet so the program will not open yet.  

7. Go to the computer where the database had been. Open Windows Explorer (not internet 
Explorer).  

8. Navigate to the database (Hrware.gdb), “Copy” it, Paste it into a shared folder on the 
network and close Windows Explorer.  

9. Go to the new server and navigate to the shared folder and “Copy” the database 
(hrware.gdb).  

10. Navigate to the new, “blank” database (hrware.gdb). Paste the copy of the original 
database into the same folder. This will overwrite the new, “blank” database with a copy of 
your production database.  

   



Installing Gradience Files to Another Drive Other Than C:\ 

Issue: 

Installing Gradience files to another drive other than the C:\ drive. 
   

Description: 
Sometimes installing to the C:\ drive is not feasible. It may not have much space left or it’s not 
meant for database files.  
   

Possible Resolution: 
When installing Gradience, there are three sets of files that get installed: Program Files, 
Database Files and Database Engine Files (Interbase). When choosing Custom Install, you may 
select the location for the Program and Database Files that get installed at the same time. 
Interbase automatically will install to the c:\ drive after you click on the first Finish button. If this is 
OK, then you only need to follow Step 1 below and click on Finish. Otherwise, if you also want to 
install Interbase to another drive, then follow all of the below steps: 

1. Run the installation of the selected Gradience program (such as Gradience Attendance , 
Records or TimeClock. When going through the installation process, choose Custom for 
the Installation Type. For the next two screens (Program Files and Database Files 
Location), click Browse to choose where to install them.  

2. Stop at the point where it says FINISH. Do not click on it. Leave the install window open at 
this screen. Open Windows Explorer and go to the Windows Temp directory. 

3. From the Windows Temp directory, find (or do a search for) IBWin32setup.exe. 
4. Double-click on this file to start the installation process. This will install the database 

engine files (Interbase) and give you the ability to install these files to a drive other than 
C:\.  



Install Update from One Location  

Issue: 
When a new update is released, you must install at each client workstation(s) and at the 
database server. These instructions will show you how to set up the Gradience folders to install 
only the new update once from one central location.  
   

Description: 

Setting up one shared directory for the program files will make updates quicker and easier.  
   

Possible Resolution: 
These instructions will explain how to set up the Gradience program files in one shared location 
to make updating easier: 
   

1. Copy the Gradience installation file(s) to a shared directory. The Server and all 
workstations that will have (or already have) Gradience installed should have access to 
this shared directory on the network. If you downloaded the Gradience update from our 
Web site (www.gradiencesupport.com), then you will have only one file. If you have a 
Gradience CD, then you will need to copy the appropriate Gradience program keeping all 
of its folders intact. For example, while navigating the Gradience CD through Windows 
Explorer, under the BIN folder, you would copy the Atcon70 folder to the shared directory.  

2. From the Server (or computer where the database resides), navigate to the shared 
directory, and run the Server installation (even if the Gradience program already is 
installed on the Server) by following these steps: 

1. At the Setup Type, select  Server. Click  Next. 
2. At the Installation Type, select  Custom. Click Next. 
3. At Select Components, leave the defaults. Click Next. 
4. At the Program Files Location, click Browse and navigate to the Shared directory. 

Add \Gradience to the end of the Path. 
5. At the HRWare Database Files  Location, click Next. 
6. Write down or print the Server Name and path. These will be needed for the Client 

installs. Click Close, then Next. This will install the Server files. 
7. If the Interbase install starts, click Next to install it; otherwise, go to Step  H. 
8. Go to Client Workstation. 

3. From the Client Workstation, navigate to the shared directory, and run the Gradience 
installation (even if the Gradience program already is installed on the Workstation) by 
following these steps:  

1. At the Setup  Type, select  Client. Click  Next. 
2. At the Installation  Type, select  Custom. Click  Next.  
3. At Select  Components, leave the defaults. Click  Next. 
4. At the ProgramFiles Location, click Browse, and navigate to the \Gradience 

shared directory created during the Server install. Click Next. 
5. At the Database Server Information screen, enter the Server name and database 

path exactly as shown from the Server install.  
6. Click Next. This will install the program files. 
7. Follow the above steps for any other Client Workstations that will have Gradience 

installed. 
   
When the above steps are completed once, then when you need to install an update, only 
steps 1 and 2 (a-g) need to be completed. All users must exit the Gradience program(s) before 
updating. All of the shortcuts on the Client Workstations will be pointed to the shared directory 
that will be updated when the Server install is completed. 
   



Using the Notes/Comments Editor and Attachments 

  
Gradience Records 2008 includes new, powerful word processing features for all comments and 
notes fields, as well the ability to attach objects and documents within these fields. When 
documenting employee absences, you may find it useful to attach, copies of e-mails, Word or 
Excel attachments that you’ve used for tardies, warnings and specific sections of reviews 
Gradience Forms personnel forms for vacation requests, FMLA requests and company 
responses, warnings and counseling reports 
  

Right-Click Menu Commands 
Right-click on any notes or comments field – the menu shown at right will pop up with the 
following options: 

• Edit – Opens the full text editor 
• Cut – Copies to the clipboard and deletes the currently selected text 
• Copy – Copies the currently selected text to the clipboard 
• Paste – Pastes the currently selected text into the comments or text field 
• Font – Brings up a standard font edit window, with settings for font, style, size, effects and 

color 
• Bullet Style – Toggles bullets for selected paragraphs on and off 
• Paragraph – Brings up a standard paragraph settings window for alignment style, 

indentation, and line spacing 
• Tabs – Lets you set tab stops for selected paragraphs 
• Find – Searches for the text you enter 
• Replace – Searches and replaces text according to your settings 
• Insert Object … – Opens the Insert Object window and lets you select either a type of new 

object to insert into the notes / comments field or attach an existing file 
• Check Spelling – Launches the Microsoft®Word spell checker 

  

Using the Rich Text Editor 
  

When you right-click and select Edit, the text editor opens in a separate window, giving you 
access to all Right-Click Menu commands in a word-processor-like environment. Here’s a brief 
overview: 
  

Toolbar 

 New Creates a new document. 

 Print Prints document. 

 Find Finds specified text. 

 Spell 
Check 

Checks spelling. Requires MS Word installed. 

 Cut Cuts selection and puts it on the clipboard. 

 Copy Copies selection to clipboard. 

 Paste Pastes selection from clipboard. 

 Undo Reverses the last action. 

 Redo Reverses the last Undo action. 
Format Bar 

 Font Type Changes the font selection. 

 Font Size Changes the font size. 

 Bold, 
Italic, 
Underline 

Changes the font to Bold, Italic or Underline. 

 Font 
Color 

Changes the font color. 



 Left, 
Center, 
Right 
Alignment 

Changes the text to Left, Center, or Right Alignment. 

 Bullet Inserts Bullet. 

 Highlight Highlights selected text. 



Adding Attachments to Comments or Notes 

  
Each Comment or Note field allows you to insert an attachment to that field. Attachments can be 
a Microsoft®Word Document, Microsoft® Excel spreadsheet, PDF, Rich Text Format, or even a 
picture file. Attachments may be linked to a file, displayed as an icon or inserted into the field. 
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